Symptom Check List and Functional
Specialization in the Brain
Link Between Structure and Function
Brodmann Areas
Korbinian Brodmann received a medical degree in Berlin in 1895 and then
pursued studies in the histology and cytology of the human cerebral cortex. This was an
exciting time in the history of neuroscience due to the fresh biological linkages between
structure and function advanced by the invention of the microscope and the new
mathematics of physics. The surge of powerful scientific tools and precise measurement
gave rise to the first Brain Research Institutes in Germany with the goal of localization of
function to particular regions of the brain. There was no separation between psychiatry
and neurology and the linkage between structure and function was a driving force of all
biological science. This linkage included understanding how the ‘soul’ of the human
brain operates to give rise to consciousness, feelings, thoughts and action. In the late
1800s Nissl and Golgi stains, for the first time, were illuminating the cellular structure of
the cerebral cortex demonstrating layering of pyramidal neurons and a differentiated
cytoarchitecture of the cortex including clusters of different types of cortical neurons in
different regions.
Brodmann integrated ideas on phylogenetic and ontogenetic influences with his
theories of cortical structure, function and pathology. Brodmann argued that if a cortical
region exhibits similar cytoarchitecture and layering then, based on structure and
function, there must be a shared function of the neurons in that region. Further, he
argued that regions with different cytoarchitecture exhibit different functions (Brodmann,
1909). He compared localization in the human cortex with a number of other mammals,
including primates, rodents and marsupials. In man, he distinguished 47 areas, each
carrying an individual number, and some being further subdivided. The subdivisions
ranged in surface area from about 1 square cm to 6 square centimeters and are the same
Brodmann areas used today and the original Brodmann text can be downloaded at:
http://www.appliedneuroscience.com/Brodmann-pdf.pdf
A remarkable historical fact is that Brodmann’s areas or subdivisions are a
mainstay of modern neuroscience and neuropsychology in the 21st century. For
example, the Human Brain Project uses Brodmann areas as one of the basic
nomenclatures of cortical structure and function with co-registration between different
imaging modalities such as MRI, PET, fMRI and EEG/MEG that also rely upon
Brodmann areas (Thatcher et al, 1994; 1995). The use of Brodmann areas with
coordinates, defined in the Talairach and MNI atlas, provides a common coordinate
system for all modern neuroimaging and provides an immediate co-registration of
structure-function measures in EEG/MEG based on the science of the MRI, fMRI, DSI,
PET and SPECT.
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The Human Electroencephalogram: What is the spatial extent
of Function?
What is important is not that 100% of 10 - 100 million neurons must be
simultaneously active to be detected, but rather that approximately 50% of the electrical
potential at the scalp surface comes from generators directly underneath the recording
electrode (1 cm) and 95% comes from sources 5 – 6 cm distant no matter what the
amplitude. It is not necessary for 10 million neurons to be simultaneously active to
generate an electrical potential at the scalp surface, rather the amplitude (A) of the EEG
varies as a function of the number of synchronous synaptic generators (M) times the
square root of the number of asynchronous generators (N) (Nunez, 1981; 1994),

A= M N
thus waxing and waning of the EEG is due to the ratio of M to N from moment to
moment and this proportion is oscillatory in time with abrupt phase shifts and couplings
between local and distant neurons.
The highest amplitude of the EEG is produced by synapses located on radially
oriented dendrites and soma in the crest of cortical gyri underneath each scalp electrode.
Sources in the walls of gyri (tangential) and in the sulcus (radial) also contribute but less
so and for MEG only tangential sources on the walls of the gyri contribute to the MEG
signal. This is one of the major differences between EEG and MEG. Steriade (2006)
reviews 40 years of science and shows the importance of cortico-thalamic, thalamocortical and cortico-cortical loops involved in the coordination of EEG oscillations. In
local domains, Dwyer et al (2010) and Hutcheon (1999) show that EEG is produced by
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circulation or oscillations in excitatory loops between the upper and lower layers of the
cortex with electrical and chemical synapses regulating the local and horizontal
synchrony of pyramidal neurons across centimeters of distance.
Studies by many clinical qEEG scientists, for example, Walter Freeman, Valeria,
John, Buzsaki and many others in the 1980s and 1990s discovered a fundamental
relationship between the probability of action potential firing and the Local Field
Potentials (LFPs) in the general vicinity of neurons. Neurons fire only 50% of the time
because they are most excitable on the depolarizing phase of the LFP where activation of
neurons occurs when they are phase shifted “In-Phase” with respect to the LFP and are
suppressed when phase shifted to “Anti-Phase” with respect to the LFP. Thus, at any
instant of time the amplitude and frequency of the EEG constitutes the summation of
LFPs and the EEG is a moment-to-moment measure of the excitability of action potential
firing like gates opening and closing on the half cycle. The amplitude of the EEG is
directly proportional to the probability distribution of synchronous action potentials.
This does not mean that action potentials themselves contribute to the scalp EEG but
rather that the probability of action potential firing is related to the depolarizing phase of
the EEG recorded at any scalp location.
Phase differences between electrical sources located in different Brodmann areas
are easily measured in the human electroencephalogram. Cross-frequency phase
synchrony, for example, theta (4-7 Hz) rhythms phase locked to beta (13 – 20 Hz) or
delta and alpha or alpha and gamma, etc. is an important information processing method
in the human brain. Coherence is a measure of the temporal stability of phase
differences between different scalp locations and different functional systems are phase
locked across brain regions for varying periods of time (e.g, 100 msec to 500 msec) and
then released by a subsequent phase shift that recruits a different set of neurons to then
become phase locked. Phase shifts are correlated with reduced EEG amplitude and
‘asynchrony’ while phase lock is correlated with increased rhythm amplitude and
‘synchrony’.
As previously mentioned, Brodmann (1909) argued from a “structure-function”
point of view that if the cytoarchitecture is the same then function must also be the same
and on this basis he created his sub-divisions. Thus, based on Brodmann areas then the
EEG is measuring function that is macro in scale and spatially limited to Brodmann areas
( 1 to 6 cm). Importantly, neurons rapidly synchronize and the spatial extent of global
or macro function is about 1 cm to 6 cm if fMRI or PET or any other imaging modality is
used. This indicates that synchronization of large groups of pyramidal neurons is itself a
fundamental property of information processing in the human brain. Another important
fact is that the axonal connections of the human cortex are arranged in six basic clusters
referred to as ‘Modules’ as measured by Diffusion Imaging Spectroscopy (Hagmann et
al, 2008). The synaptic density of connections is spatially heterogeneous and clustered
with phase shift and phase lock between clusters or Modules providing the ‘vitality’ or
temporal dynamics of the EEG as determined in highly stable loops in thalmo-cortical,
cortico-thalamic and cortico-cortical connections. Pacemakers and natural resonance of
pyramidal neurons and loops give rise to stable rhythms that operate like a “Carrier
Wave” in which phase shift of neurons to “In-Phase” with respect to the local field
potential (LFP) are orchestrated by phase shift and phase lock mechanisms that are easily
measurable in real-time by standard quantitative EEG methods (Wang, 2010).
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Symptom Check List Linkage Between Structure and Function: Surface EEG
Based on these facts and other supporting science a “Symptom Check List” (SCL)
was developed with the goal of linking structure to function based on the spatial overlap
of functional and clinical studies using fMRI, PET and EEG/MEG as well as the clinical
neurological science of strokes, tumors and lesions. The specific literature citations and
sources for the SCL are provided in Appendix A.
To activate the symptom check list one must download, install and launch the free
Neuroguide from:
http://www.appliedneuroscience.com/ContactDownloadDemo.htm then click File >
Open > Lexicor > Lexicor NRS24 and then type in age 55, select the eyes closed
condition and click OK. Then click Edit > Select All, then click Report > Symptom
Check List Protocol Creation to activate the Symptom Check list window and scroll
down to “Spatial Perception Problems” and double click on the Severity and type 10
because the EEG is from a patient with right parietal lobe damage and has symptoms of
spatial neglect and left sided paresis. The SCL generates a scalp model of likely brain
regions expected to be related to the patient’s symptoms in the “Hypotheses” head. The
“Match” head shows the EEG Z scores in the patient’s record that match the
hypothesized locations and the “Mismatch” head shows the significant EEG measures
that failed to match the hypothesized locations. It is possible that the mismatches
represent “compensatory” processes and in this way one can focus on the most likely
“weak” brain systems linked to the patient’s symptoms as discussed by Alexander Luria
(Luria, 1973). The “Protocol” on the right is a listing of measures that matched the
hypothesized locations and can be saved in a file and are automatically available to
perform EEG biofeedback. For further details, click Help > NeuroGuide Help and then
open the Chapter on Neurofeedback and Symptom Check list inside of the Neuroguide
Manual. Below is an example of the SCL panel with the “Symptoms” selected. The
second screen is the SCL panel with “Neuropsychological Diagnoses” selected. A
listing of these two different symptom check lists is available in Appendix – A and B.
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Behavioral Symptom Check List

Neuropsychology Category Check List
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Symptom Check List Linkage Between Structure and Function: LORETA
The same scientific literature review of the fMRI, PET and EEG/MEG literature
that links symptoms and neuropsychological diagnoses to functional specialization in the
brain was used to provide a linkage to the 3-dimensional sources of the scalp EEG. We
use Low Resolution Electromagnetic Tomographic Analysis or “LOERTA” that has a 7
mm cubic spatial resolution and adequately measures all of the Brodmann areas as
evidenced by 795 peer reviewed journal articles that can be read at:
http://www.appliedneuroscience.com/LORETA%20publications.pdf

To activate the LORETA symptom check list one must download, install and
launch the free Neuroguide from:
http://www.appliedneuroscience.com/ContactDownloadDemo.htm then click File >
Open > Lexicor > Lexicor NRS24 and then type in age 55, select the eyes closed
condition and click OK. Then click Edit > Select All, then click Report > Create
Symptom Check List Match and then save the .scl file in a folder. Then click Collection
> Setup & Monitor and then click OK. Click Collection > Neurofeedback > LORETA
Neurofeeback. Click Symptom Check List in the settings panel and open the .scl file that
was previously saved. Scroll down to “Spatial Perception Problems” and double click on
the Severity and type 10 because the EEG is from a patient with right parietal lobe
damage and has symptoms of spatial neglect and left sided paresis. The SCL generates
a list of likely Brodmann areas expected to be related to the patient’s symptoms in the
“Hypotheses” in the lower right list. The “Match” list shows the statistically significant
Brodmann areas in the patient’s record that match the hypothesized locations and the
“Mismatch” shows the Brodmann areas that failed to match the hypothesized locations.
It is possible that the mismatches represent “compensatory” processes and in this way
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one can focus on the most likely “weak” brain systems linked to the patient’s symptoms
as discussed by Alexander Luria (Luria, 1973). Click OK to return to the settings panel
and view the Brodmann areas and regions of interest that were automatically generated
by the symptom check list match. For further details, click Help > NeuroGuide Help and
then open the Chapter on Neurofeedback and Symptom Check list inside of the
Neuroguide Manual. Below is an example of the SCL panel with the “Symptoms”
selected and the Brodmann areas selected based on the match of symptoms and regions of
the brain. The second screen is the SCL panel with “Neuropsychological Diagnoses”
selected. A listing of these two different symptom check lists is available in Appendix –
D.
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Appendix A- Scientific Literature Used to Create the Symptom Check
List
The literature that was relied upon is available in the National Library of
Medicine’s database at:
https://www.ncbi.nlm.nih.gov/sites/entrez?db=pubmed and at:
http://www.appliedneuroscience.com/Brain%20&%20Behavior.htm
The following textbooks were relied upon:
1- The Brain and Behavior: An Introduction to Behavioral Neuroanatomy, D.L.
Clark, N.N. Boutros and M.F. Mendez, Cambridge University Press, 2010
2- Localization of Clinical Syndromes in Neuropsychology and Neuroscience. J.M.
Tonkonogy and A.E. Puente, Springer Pub. Co, N.Y., 2009
3- Localization in Clinical Neurology. P.W. Brazis et al, Lippincott Williams &
Wilkins, Philiadelphia, PA 2007
4- Brodmann's Localization in the Cerebral Cortex, Translated by L. J. Garey.
Springer, London, 1994
5- Principles of Behavioral and Cognitive Neurology, 2nd ed., M.-Marsel
Mesulam. Oxford University Press, 2000
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6- The Working Brain: An Introduction to Neuropsychology, A. R. Luria, Penguin
Press, 1973
References in Text:
Nunez, P. (1981). Electrical Fields of the Brain. Oxford University Press, New York.
Nunez, P. (1994). Neocortical Dynamics and Human EEG Rhythms, Oxford University
Press, New York.

Appendix B- Surface EEG List of Symptoms
Symptoms
Anosognosia - Denial of a Problem
Anxiety
Attention Deficits - Easily Distractible
Auditory Sequencing Problems
Balance Problems
Blurred Vision
Chronic Pain
Compulsive Behaviors and/or Thoughts
Concentration Problems
Decreased Tactile or Skin Sensitivity
Delusional
Depression (Sad & Blue)
Difficulty Comprehending Social Cues
Dyscalcula - Problems Calculating
Dyslexia - Letter Reversal
Executive Function Problems
Face Recognition Problems
Failure to Initiate Actions
Hyperactive and/or Agitation
Impulsive Behaviors
Insensitive to Others Emotional Expressions
Insensitive to Other's Feelings
Low Motivation
Low Threshold for Anger & Loss of Control
Migrane Headaches
Mood Swings
Multi-Tasking Problems
Obsessive Thoughts about Self
Obsessive Thoughts and/or Hyper Focused
Oppositional Defiant Conduct
Orientation in Space Problems
Perception of Letters Problems
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Poor Judgement
Poor Skilled Motor Movements
Poor Social Skills
Receptive Language Problems
Recognizing Objects by Touch Problems
Self-Esteem Problems
Sequential Planning Problems
Short-Term Memory Problems
Slow Reader
Slowness of Thought - Easily Confused
Spatial Perception Problems
Speech Articulation Problems
Symptoms of Fibromyalgia
Word Finding Problems

Appendix C – Surface EEG List of Links to the Neuropsychological
Literature
Neuropsychological Diagnoses
Agnosia of Action Apperceptive
Agnosia of Action Associative
Agnosia Auditory Apperceptive
Agnosia Auditory Associative
Agnosia Auditory Space
Agnosia Prosopagnosia (Face)
Agnosia Social Emotional
Agnosia Social of Action - Theory of Mind
Agnosia Somatosensory Autotopagnosia
Agnosia Somatosensory Finger
Agnosia Somatosensory Anasognosia of Aphasia
Agnosia Somatosensory Pain
Agnosia Somatosensory Blindness
Agnosia Somatosensory Left Hemiplegia
Agnosia Somatosensory Right Hemiplegia
Agnosia Somatosensory Mental Illness
Agnosia Tactile Apperceptive
Agnosia Tactile Associative
Agnosia Visual Topographic
Agnosia Visual Acronomatopsia
Agnosia Visual Anomia Color
Amnestic Disorder Anterotrograde
Amnestic Disorder Working Memory
Amnestic Disorder Transient Global amnesia (TGA)
Amnestic Disorder Reduplicative Paramnesia
Aphasia Anterior Broca's
Aphasia Anterior Transcortical Motor
Aphasia Anterior Articulation
Aphasia Posterior Wernicke's
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Aphasia Posterior Transcortical Sensory
Aphasia Posterior Conduction
Aphasia Posterior Word Deafness
Apraxia Motor Constructional
Apraxia Motor Dressing
Apraxia Motor Gate, Trunk
Apraxia Motor Ideational
Apraxia Motor Ideomotor
Apraxia Motor Limbkinetic
Apraxia Motor Oral
Apraxia Social Disorganization of social actions
Apraxia Visual Topographic
Aspontaneity Abulia and/or Apathy
Aspontaneity Akinetic Mutism
Aspontaneity Catonia
Attenional Disturbances Balint's Syndrome
Attenional Disturbances Neglect
Attenional Disturbances Excessive Shifting of Attention
Delusions Capgras Syndrome
Delusions Grandiose
Delusions Guilt
Delusions Persceutory
Disturbances of Self-Image Depersonalization
Disturbances of Self-Image Derealization & SelfAwareness
Disturbances Visual-Spatial Disorientation
Disturbances Visual-Spatial Topograhpic Agnosia
Disturbances Visual-Spatial Topograhpic Apraxia
Hallucinations Auditory Elementary
Hallucinations Auditory Complex
Hallucinations Visual Elementary
Hallucinations Visual Complex
Mood Disturbances Agression, Rage
Mood Disturbances Mania
Mood Disturbances Panic
Mood Disturbances Obsessive Compulsive
Mood Disturbances Secondary Depression
Loss of Visual Imagery Objects
Loss of Visual Imagery Space

Appendix D –Brodmann Areas and Structure-Function
Under Construction based on Links to the National Library of
Medicine Database of EEG/MEG and/or fMRI and/or PET/SPECT studies.
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Links are not compete and are adapted from David Kaiser
http://www.skiltopo.com/B1/functions.htm#B1123L

Brodmann Area 1 - Post Central Gyrus (Somatosensory
Unimodal Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•

Homunculus (1)
Localize pain (1, 2, 3, 4)
Localize touch and vibration (1, 2, 3, 4, 5, 6, 7)
Localize temperature ( 1, 2, 3, 4)
Sense of fingers (1, 2, 3)
Sense of body (1)
Move hands (1, 2)
Move mouth and tongue (1, 2)
Swallowing (1, 2, 3)
Anticipate pain (1)
Anticipate tickling (1)
Mirror neurons (1, 2, 3)

Brodmann Area 2 - Post Central Gyrus (Somatosensory
Unimodal Cortex - Mesulam, 1999)
• Homunculus (1)
• Agraphesthesia

Brodmann Area 3 - Post Central Gyrus (Somatosensory
Unimodal Cortex - Mesulam, 1999)
• Homunculus (1)

Brodmann Area 4 - Pre Central Gyrus (Somatosensory
Unimodal Cortex - Mesulam, 1999)
• Muscle sequences (1, 2, 3)
• Move hands(1, 2, 3, 4, 5)
• Limbs (1, 2, 3)
• Sense of our fingers (1, 2, 3)
• Softness and vibration (1, 2, 3)
• Move tongue and mouth (1, 2, 3, 4, 5)
• Actions, Touches (1, 2)
• Swallow (1, 2, 3, 4)
• Voluntary breathing (1, 2, 3, 4)
• Muscle imagery (1, 2, 3, 4)
• Blinking (1, 2)
• Eye movements (1, 2, 3)
• Bicycling (1)
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• Tactile (1)

Brodmann Area 5 - Parietal Lobe Economo-Koskinas
area PE (Somatosensory Unimodal Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Ordered & chaotic pattern perception (1)
Spatial imaging in deductive reasoning (1)
Imagery of movement (1, 2, 3)
Tool-use and gestures (1, 2)
Imitation learning (1)
Mirror neurons for movement (1)
Bimanual coordination (1)
Saccades (1, 2, 3)
Working memory (1, 2, 3, 4)
What & where of touch (1)
Localizing pain (1)
Motor attention (1, 2)
Imitating finger movements (1)
Spatial mnemonic processing (1)

Brodmann Area 6 - Frontal Lobe Economo-Koskinas
area FB (Motor Association Cortex Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Sequential movements (1, 2, 3)
Object recognition (1)
Sensorimotor willed actions (1)
Word repetition (1)
Attention to visual motion (1)
Action Knowledge (1)
Feigned memory impairment (1)
Action learning (1, 2, 3, 4, 5)
Start moves (1, 2)
Muscle imagery (1, 2, 3)
Imagined moves (1, 2, 3, 4)
Voluntary breathing (1, 2, 3)
Saccades (1, 2, 3)
Laughter, smiling (1)
Words (a, b, c)
Language (a, b)
Language switching (a)
Understand speech (a, b)
Lipreading (a)
Human voices (a)
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•
•
•
•
•
•
•
•
•
•
•
•
•
•

Acoustic rhythms (a, b)
Generate melodies (a)
Working memory (1, 2, 3, 4)
Mnemonics (1, 2)
Episodes (1)
Topographic memory (1)
Locations (1, 2, 3)
Self-reflection (1)
Update locations (1)
Eye guidance (1)
Observe Actions (Mirror neurons) (1, 2, 3, 4)
Solve novelty (1, 2)
Orchestrate (1)
Calculation (1, 2)

•
•
•
•
•
•

Speech muscles (1, 2) - Left Hemisphere
Novel words (1) - Left Hemisphere
Phonemes (1) - Left Hemisphere
Object names (1, 2) - Left Hemisphere
Deduction (1, 2) - Left Hemisphere
Inhibit response (1) - Left Hemisphere

•
•
•
•

Sequential moves (1) - Right Hemisphere
Monitor errors (1) - Right Hemisphere
Strong odors (1) - Right Hemisphere
Same or different (1) - Right Hemisphere

Brodmann Area 7 - Supramarginal Gyrus
Somatosensory Association Cortex
• Economic decisions (1)
• Conscious awareness of visual-spatial events (1 ) - Bilateral
• Goals (1) - Bilateral
• Activation at rest - Default Brain (1) - Bilateral
• Pain (1)
• Recall episodes (1) - Left Hemisphere
• Tool use (1) - Left Hemisphere
• Handwriting and spelling (1) - Left Hemisphere
• Shift attention (1) - Left Hemisphere
• Language (1) - Left Hemisphere
• Literalness (1) - Left Hemisphere
• Imageability (1) - Left Hemisphere
• Personal space (1, 2) - Right Hemisphere
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•
•
•
•
•
•

Estimate (1) - Right Hemisphere
Meta-emotions (1) - Right Hemisphere
Visuospatial attention (1) - Right Hemisphere
Mental rotation (1, 2) - Right Hemisphere
Stereopsis (1, 2) - Right Hemisphere
Line bisection judgments (1) - Right Hemisphere

Brodmann Area 8 - Pre-Frontal Cortex (Association Cortex Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Muscle learning (1, 2, 3, 4)
Muscle imagery (1, 2)
Muscle control (1, 2)
Saccades (1, 2)
Laughter, smiling (1)
Executive control (1, 2, 3, 4)
Planning (1, 2)
Speech programs (1)
Language processing (1)
Language translation (1)
Generating sentences (1)
Lipreading (1)
Working memory (1, 2, 3 )
Perceptual priming (1)
Topographic memory (1)
Visuospatial and visuomotor attention (1)
Retrieval of words (1) - Right Hemisphere
Sequence learning (1, 2)
Proprioceptive stimulation (1, 2, 3)
Pain anticipation (1)
Processing uncertainty (1)
Inductive reasoning (1)
Calculation (1, 2)
Auditory imagery (1)
Memory retrieval (1, 2)
Nonconscious saccades (1)

Brodmann Area 9 - Pre-Frontal Cortex EconomoKoskinas area FD (Frontal Association Cortex)
• Male and female sexual arousal (1)
• Word identification (1)
• Economic decisions (1)
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• Lie detection (1)
• Viewing of unpleasant pictures (1)
• Short-term memory (1)
• Recency (1)
• Orchestrate behavior (1)
• Verbal fluency (1)
• Word-stem completion (1)
• Error detection (1)
• Human voices (1) Infer (1, 2,)
• Intentions (1)
• Action authorship (1)
• Energize (1)
•
•
•
•

Generate sentences (1)
Inference (1, 2)
Idioms (1, 2, 3)
Categorization (1)

•
•
•
•
•
•
•
•
•

Suppress sadness (1)
Working memory (1, 2, 3)
Spatial memory (1, 2)
Recognition (1, 2, 3)
Recall (1, 2, 3)
Recognize emotions (1)
Planning (1)
Calculation (1, 2)
Familiar odors (1)

Brodmann Area 10 - Pre-Frontal Cortex EconomoKoskinas area FD (Frontal Association Cortex)
•
•
•
•
•
•
•
•
•
•

Working memory (1, 2, 3) - Bilateral
Spatial memory (1, 2) - Bilateral
Recognition (1, 2, 3) - Bilateral
Recall (1, 2, 3) - Bilateral
Intentional forgetting (1) - Bilateral
Nonspeech sounds (1) - Bilateral
Recognize emotions (1, 2) - Bilateral
Calculation (1, 2) - Bilateral
Pain (1) - Bilateral
Joint attention (1) - Bilateral

• Syntax(1) - Left Hemisphere
• Metaphor (1) - Left Hemisphere
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• Lexical (1) - Left Hemisphere
• Verbs (1) - Left Hemisphere
•
•
•
•
•
•
•
•
•

Self-reflection (1) - Right
Self-appraise (1) - Right
Economic decisions (1) - Right
Inferences during reading (1) - Right Hemisphere
Recall episode (1) - Right Hemisphere
Nonspeech sounds (1) - Right Hemisphere
Familiar odors (1) - Right Hemisphere
Reward vs conflict (1) - Right Hemisphere
Risk vs benefit (1) - Right Hemisphere

Brodmann Area 11 - Higher Order Assocation and
Orbital Frontal Association Cortex (Paralimbic Posterior Mesulam, 1999)
• Olfaction (1, 2) - Bilateral
• Nonspeech sounds (1) - Bilateral
• Reward vs conflict (1, 2) - Bilateral
• Unexpected outcomes (1) - Left Hemisphere
• Idioms (1) - Left Hemisphere
• Face-name (1) - Left Hemisphere
• Self-calm (1) - Right Hemisphere
• Odors (1) - Right Hemisphere
• Encoding of words (1) - Right Hemisphere

Brodmann Area 12 - Frontal Lobe (12/47 EconomoKoskinas area FD (Paralimbic & Association Cortex - Mesulam, 1999)
•
•
•
•
•
•

Hypothesis generation (1)
Same different discrimination (1)
Decision making (1)
Affective value of reinforcers (1)
Sensitivity to reward and punishment (1)
Expectation (1)

Brodmann Area 13 - Insular Cortex Economo-Koskinas
area FF (Paralimbic Cortex - Mesulam, 1999)
• Dissociated PTSD (1)
• Maternal and romantic love (1)
• Seeing or making a smile (1)
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Interoceptive Body Status pain localization (1, 2, 3, 4)
Attend to happy voices (1)
Hearing pleasant music (1)
Reward fluctuation (1)
Pain processing (1, 2, 3, 4, 5)
Feeling joyful (1)
Female self reported orgasm ratings (1)
Mothers viewing photos of their own child (1)
Mirror movement neurons (1, 2)
Female sexual arousal to erotica (1)
Retrieval of words (1)
Heat (1, 2)
Touch (1, 2)
Vibration (1)
Vestibulation (1)
Olfaction and taste (1, 2, 3)
Verbal memory (1, 2, 3)
Action planning (1)
Swallowing (1)
Categorization (1, 2)
Error awareness (1)
Motivated reasoning (1)
Risk-taking (1)
Emotional inhibition (1)
Express fear or disgust (1, 2, 3)
Vocal pitch (1)
Humor appreciation (1)
Phonemes (1)

Brodmann Area 14 - only present in monkeys
Brodmann Area 15 - only present in monkeys
Brodmann Area 16 - only present in monkeys
Brodmann Area 17 - Occipital Cortex EconomoKosinas area OB (Primary Visual Unimodal Cortex - Mesulam, 1999)
• Light intensity (1, 2, 3, 4)
• Orderly visual patterns (1, 2)
• Contours (1, 2, 3)
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•
•
•
•
•
•

Colors (1, 2, 3)
Spatial orientation (1, 2, 3)
Motion (1)
Visual attention (1, 2, 3, 4)
Visual priming (1, 2, 3)
Help saccade eyes (1)

Brodmann Area 18 - Occipital Cortex EconomoKosinas area OB (Primary Visual Unimodal Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•

Light intensity (1, 2)
Motion (1)
Orderly visual patterns (1, 2)
Understand finger gestures (1)
Monitor color and shape (1, 2)
Visual priming (1, 2)
Face-name (1)
Help saccade eyes (1)

Brodmann Area 19 - Occipital Cortex EconomoKosinas area OA (Primary Visual Unimodal Cortex - Mesulam, 1999)
• Conscious awareness of visual-spatial events (1 ) - Bilateral
• Dissociated PTSD (1)
• Light intensity (1, 2) - Bilateral
• Reflective self-awareness (1, 2)
• Visual patterns (1, 2) - Bilateral
• Motion (1, 2, 3, 4) - Bilateral
• Understand finger gestures (1) - Bilateral
• Activation at rest - Default Brain (1)
• Sign language (1)
• Monitor color and shape (1)
• Feature-based attention (1)
• Orientation-selective attention (1)
• Visual priming (1) - Bilateral
• Visual memory recognition (1)
• Spatial working memory (1)
• Phonological demands (1)
• Saccades (1)
• Visual imagery (1, 2)
• Inferential reasoning (1)
• Animacy (1)
• Visuospatial challenge (1)
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•
•
•
•
•
•
•
•

Motion (1)
Visuo-spatial (1, 2)
Visual priming (1)
Visual recognition (1)
Spatial working memory (1)
Face-name (1)
Saccades (1)
Visual imagery (1)

Brodmann Area 20 - Temporal Lobe (Auditory Association
Cortex - Mesulam, 1999)
• Visual fixation (1) - Bilateral
• Identify intention (1) - Bilateral
•
•
•
•
•
•
•
•

Suspicion (1) - Left Hemisphere
Truth telling (1) - Left Hemisphere
Process latter parts of sentences (1) - Left Hemisphere
Visual categorization (1) - Left Hemisphere
Lexical categories (1, 2) - Left Hemisphere
Metaphor comprehension (1) - Left Hemisphere
Language comprehension and production (1) - Left Hemisphere
Monitor speech (1) - Left Hemisphere

• Category ambiguity (1) - Right Hemisphere
• Perceptual closure (1) - Right Hemisphere
• Working memory (1) - Right Hemisphere

Brodmann Area 21 - Temporal Lobe Auditory
Economo-Kosinas area TE (Unimodal Cortex - Mesulam, 1999)
•
•
•
•

Categorization (1, 2, 3) - Bilateral
Observe motion (1) - Bilateral
Complex sounds (1) - Bilateral
Attribute intention (1) - Bilateral

•
•
•
•
•

Verbal associated novelty (1) - Left Hemisphere
Monitor text and speech (1, 2) - Left Hemisphere
Sentence generation (1) - Left Hemisphere
Word generation (1) - Left Hemisphere
Deductive reasoning (1, 2) - Left Hemisphere

• Prosody (1, 2) - Right Hemisphere
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Brodmann Area 22 - Temporal Lobe Auditory
Economo-Kosinas area TA (Auditory Association Cortex - Mesulam,
1999)
•
•
•
•
•
•
•
•
•
•
•

Sentence generation (1)
Attend to happy and angry voices (1)
Word generation (1)
Monitor speech (1)
Repeating words (1)
Complex sounds (1)
Deductive reasoning (1)
Auditory language (1, 2)
Categorization (1, 2)
Learning tone-based 2nd language (1)

• Affective prosody (1)
• Nonverbal sounds (2)
• Previous eye movements (1)

Brodmann Area 23 - Posterior Cingulate Gyrus
Economo-Koskinas area LC (Paralimbic Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•

Activation at rest - Default Brain (1)
Emotional words (1)
Action memory (1, 2, 3)
Episodic retrieval (1)
Recall (1)
Resolve proactive interference (1)
Learn complex procedure (1)
Finger movements (1)
Temperature processing (1)
Visual discrimination (1)
Evaluative judgment (1)
Self/other distinction (1)
Classical conditioning (1)

•
•
•
•
•
•
•

Lexical categories (1, 2)
Fear conditioning (1)
Threatening words (1)
Mood swings (1)
Cortical hub in infancy (1)
Disconnects with trauma (1)
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• Word and face encoding (1)

Brodmann Area 24 - Anterior Cingulate Gyrus (Paralimbic
Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Inhibition (1, 2, 3)
Hearing happy music (1)
Emotional cues (1, 2, 3)
Muscle strategy (1, 2, 3)
Muscle imagery (1)
Vestibulation (1, 2, 3)
Pain endurance (1, 2, 3)
Working memory (1, 2, 3)
Episodes (1)
Prospective memory (1)
Time-based memory (1)
Visuospatial attention (1, 2, 3)
Divided attention (1, 2)
Auditory attention (1, 2)
Mental timekeeping (1, 2, 3)
Self-other overlap (1, 2)
Familiar odors (1, 2, 3)
Deductive reasoning (1, 2)
Taste (1, 2)
Sexual arousal to erotica (1, 2)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Object-naming (1, 2)
Verbal fluency (1)
Induction (1)
Remembering after delay (1)
Multitasking (1)
Worry (1)
Mood swings (1)
Sustain response set (1)
Verbal initiation and suppression (1, 2)
Memory retrieval (1, 2)
Conflict monitor (1)
Monitors consequences of actions (1)
Suppress aggression (1)
Mood swings (1)
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Brodmann Area 25 - Anterior Cingulate Gyrus &
Medial Prefrontal Cortex (Paralimbic Cortex; Mesulam, 1999)
• Moral reasoning (1)
• Evaluate emotional words (1, 2)

Brodmann Area 26 - Paralimbic Cortex (Mesulam,
1999)
• Verbal associated novelty (1)

Brodmann Area 27 - Parahippocampal Gyrus and
Presubiculum - (Paralimbic Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Pattern separation (overlapping representations are made less similar) (1, 2)
Face memory (1, 2, 3)
Picture memory (1, 2)
Auditory memory (1)
Emotions (1)
Categories (1, 2, 3)
Visual memory (1)
Autobiographical memory (1, 2, 3)
Olfactory and gustatory memory (1, 2, 3)
Recognition, recall and retrieval (1, 2, 3)
Procedural memory consolidation (1, 2, 3)
Memory for novelty (1)
Memory for negative stimuli (1, 2, 3)
Face-based emotional perception (1, 2, 3)
Erotica (1, 2)
Experience stress (1)
Congruent facial movements (mirror neurons) (1)
Craving (1)
Hunger (1)
Embarassment (1)
Spatial (1, 2, 3)
Landmarks (1, 2, 3 )
Novelty (1)
Past and future events (1, 2)
Anticipating regret (1)
Insight (1)
Decision-making (1)

• Categorization (1, 2, 3,)
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Brodmann Area 28 - Parahippocampal Gyrus, Uncus
and Medial Temporal Lobe (Paralimbic Cortex - Mesulam, 1999)
• Deductive and probabilistic reasoning (1)
• Viewing of unpleasant pictures (1)
• Finer grain discriminantion (1)

Brodmann Area 29 - Posterior Cingulate & Superior
Transverse Temporal Gyrus (Cortex Paralimbic Cortex -Mesulam,
1999)
• Novelty activation (1)
• Precautions awareness (1)
• Nonconscious formation of semantic associations (1)

Brodmann Area 30 - Posterior Cingulate & Cuneus
(Paralimbic Cortex - Mesulam, 1999)
•
•
•
•
•
•

Attending to speech (1)
Listening to sentences (1)
Activation to emotional words (1)
Observation of actions by others (1)
Activation at rest - Default Brain (1)
Encoding of words (1)

Brodmann Area 31 - Posterior Cingulate Gyrus (Paralimbic
Cortex - Mesulam, 1999)
• Self-evaluation (1)

Brodmann Area 32 - Anterior Cingulate Gyrus (Paralimbic
Cortex - Mesulam, 1999)
• Visual uncertainty (1)
• Mood regulation (1)
•
•
•
•
•

Sustain response set (1)
Identify pain (1)
Self-insight (1)
Reward (1)
Reappraise negative emotions (1)
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Brodmann Area 33 - Anterior Cingulate Gyrus (Paralimbic
Cortex - Mesulam, 1999)
• Hearing pleasant music (1)
• Female sexual arousal to erotica (1)

Brodmann Area 34 - Superior Temporal Gyrus &
Subcallosal Gyrus-Entorhinal Area (Association
Cortex)
• Processing words at different levels of specificity (1)
• Dissociated PTSD (1)

Brodmann Area 35 - Medial Temporal Lobe &
Parahippocampal Gyrus (Association Cortex)
•
•
•
•

• Retrieval of words (1) - Right Hemisphere
Acquisition of new memories
Spatial mapping
Novelty detection
Short-term memory

Brodmann Area 36 - Medial Temporal Lobe &
Parahippocampal Gyrus (Association Cortex)
•
•
•
•
•

Retrieval of words (1) - Right Hemisphere
Acquisition of new memories
Spatial mapping
Novelty detection
Short-term memory

Brodmann Area 37 - Fusiform Gyrus & Middle
Temporal Gyrus (Auditory-Visual Association Cortex - Mesulam, 1999)
• Episodes (1)
• Faces (1, 2, 3)
• Motion (1, 2, 3, 4)
• Visual fixation (1)
• Monitor color and shape (1, 2)
• Intentions (1)
• Drawing (1)
• Acquisition of new memories
• Spatial mapping
• Novelty detection
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• Short-term memory
• Categorization (1, 2, 3)
• Word retrieval (1, 2, 3)
• Sign language (1)
• Metaphor (1)
• Reading (1)
• Face-name (1)
• Deduction (1)
• Numbers (1)
• Familiarity judgments (1)
• Face identity (1)

Brodmann Area 38 - Superior Temporal Gyrus and
Middle Temporal Gyrus (Paralimbic Cortex - Mesulam, 1999)
• Dissociated PTSD (1)
• Intentions (1, 2, 3)
• Moral judgments (1, 2)
• Experience emotions (1, 2, 3)
• Identify emotions (1, 2, 3, 4, 5)
• Attachment (1, 2)
• Categorization (1, 2, 3)
• Speech comprehension (1, 2)
• Verbal disambiguation (1)
• Stories (1, 2)
• Aversive sounds (1)
• Familiarity (1)
• Humor (1, 2)
•
•
•
•
•
•
•

Self/other (1, 2, 3)
Attend to speech (1, 2)
Inferences (1)
Identify social emotions (1)
Aversiveness (1)
People’s names (1)
Music appreciation (1)

•
•
•
•

Familiar voices (1)
Irony (1)
Faux pas (1)
Social behavior (1)
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Brodmann Area 39 - Angular Gyrus & Inferior Parietal
Lobe Association Cortex
•
•
•
•
•
•

Reflective self-awareness (1, 2)
Reading (1, 2)
Spatial focusing (1)
Theory of mind (1)
Executive control (1)
Action sequences (1)

•
•
•
•

Sentence generation (1)
Verbal creativity (1)
Numerical facts (1, 2)
Calculation (1, 2, 3, 4)

•
•
•
•
•
•
•

See differently from others (1)
Visuospatial (1)
Sight reading of music (1)
Self-relevance (1)
Resolve surprise (1)
Action authorship (1)
Situational context (1)

Brodmann Area 40 - Inferior Parietal Lobe Angular
Gyrus (Somatosensory Association Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Attend to phonemes (1)
Categorization (1)
Economic decisions (1)
Verbal creativity (1)
Aversiveness (1, 2)
Emotional working memory (1)
Conscious recollection (1)
Visual grasping (1)
Gesture imitation (1, 2)
Visuomotor planning (1)
Repetitive passive movements (1)
Intention/conflict detection (1)
Somatosensory (1, 2)
Motion (1, 2)
Deduction (1, 2)
Empathy (1)
Music performance (1)
Goals (1)
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• Imitate novel actions (1)
• Calculation (integer computation) (1)
• Verbal creativity (1)
•
•
•
•

Sentences (1)
Self-reflection (1)
Same or different (1)
Sustain attention (1)

Brodmann Area 41 - Superior Transverse Temporal
Gyrus - Auditory Primary (Unimodal Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•

Auditory (1, 2, 3, 4, 5)
Harmony (1, 2)
Sound intensity (1, 2 ,3 )
Pitch (1, 2)
Vowel segregation (1, 2)
Auditory priming (1, 2)
Auditory working memory (1)
Visual speech perception (1, 2)

Brodmann Area 42 - Inferior Transverse Temporal
Gyrus - Auditory Primary (Unimodal Cortex - Mesulam, 1999)
•
•
•
•
•
•
•
•

Auditory (1, 2, 3, 4, 5)
Harmony (1, 2)
Sound intensity (1, 2 ,3)
Pitch (1, 2)
Vowel segregation (1, 2)
Auditory priming (1, 2)
Auditory working memory (1)
Visual speech perception (1, 2)

Brodmann Area 43 - Gustatory Primary Cortex Postcentral and Paracentral Lobule
• Tactile digit stimulation (1)
• Spoken language (1)
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Brodmann Area 44 - Inferior Frontal and Extra
Nuclear Gyrus of the Pre-Frontal Lobes
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Word generation (1)
Unintelligible speech (1 ,2)
Attend to speech (1)
Syntactic working memory (1, 2)
Working memory (1, 2, 3)
Episodic memory (1)
Declarative memory (1)
Mirror other's movements (1, 2, 3)
Speech programs (1)
Tactile imagery (1)
Goals (1)
Word and face encoding (1)
Arithmetics (1)
Object manipulation (1)
Familiar odors (1, 2)
Music appreciation (1)

•
•
•
•
•
•
•
•

Linguistic fluency (1, 2, 3)
Grapheme-to-phoneme conversion (1, 2)
Grammar (1, 2, 3, 4)
Sequential sounds (1)
Lexical inflection (1)
Sentence comprehension (1)
Imitate finger movements (1)
Phonemes (1)

•
•
•
•
•
•

Express emotions (1)
Speech intonation (1, 2)
Sentence comprehension (1)
Inhibition actions (1)
Generate melodies (1)
Monitor actions (1)

Brodmann Area 45 - Inferior Frontal and Extra
Nuclear Gyrus of the Pre-Frontal Lobes
•
•
•
•
•

Semantic & phonological processing (1, 2, 3, 4, 5)
Generate words (1, 2, 3, 4)
Verbal fluency (1, 2, 3)
Lexical search (1, 2)
Phonemes (1, 2)
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Grammar (1)
Categories (1, 2, 3)
Sign language (1)
Reason (1, 2)
Metaphors (1, 2)
Working memory (1, 2, 3)
Episodic memory (1)
Declarative memory (1)
Digits (1)
Mirror movement neurons (1, 2)
Response inhibition (1, 2, 3)
Mental rotation (1)
Word and face encoding (1)
Aesthetic and music appreciation (1, 2)
Modulate emotions (1)

•
•
•
•
•
•

Attend to speech (1)
Lexical inflection (1)
Generate melodic phrases (1)
Familiar odors (1, 2)
Retrieving categories (1)
Phonemes (1)

• Affective prosody (1)
• Monitor actions (1)
• Timed behavior (1)

Brodmann Area 46 - Middle Frontal Gyrus
•
•
•
•
•
•
•
•
•
•
•
•

Memory recognition (1, 2, 3)
Working memory (1, 2, 3)
Categorization (1, 2, 3)
Monitor (1)
Chewing (1)
Drawing (1)
Mirror neurons (1)
Saccades (1)
Intention/conflict detection (1)
Music appreciation (1)
Willfulness (1)
Strategy (1)

• Verbal fluency (1, 2)
• Phonemes (1)
• Self-reflection (1)
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Brodmann Area 47 - Inferior Frontal
• Dissociated PTSD (1)
• Categorization (1, 2, 3, 4, 5)
• Phoneme (1, 2)
• Lexical inflection (1)
• Attend to speech (1)
• Working memory (1, 2)
• Episodic memory (1)
• Adverse emotional inhibition (1)
• Temporal coherence (1)
• Intention (1)
• Deduction (1, 2)
•
•
•
•
•
•

Idioms (1)
Make inferences during reading (1)
Categorization (1, 2, 3)
Familiar odors (1, 2, 3)
Retrieve categories (1)
Music (1)

•
•
•
•
•

Affective prosody (1)
Behavioral inhibition (1, 2)
Manage conflict and reward (1)
Monitor actions (1)
Monitor unattended information (1)

Appendix E – Neuropsychological Linkages and Structure and Function
for. This summary is based on the Clark et al, 2010 and Tonkonogy
and A.E. Puente, 2009 and adapted from:
http://www.dendrites.com/essays/cortical.htm
This summary description was chosen for its succinctness and the reader can
verify that correctness of this section by reading the books:
The Brain and Behavior: An Introduction to Behavioral Neuroanatomy, D.L. Clark, N.N.
Boutros and M.F. Mendez, Cambridge University Press, 2010
Localization of Clinical Syndromes in Neuropsychology and Neuroscience. J.M.
Tonkonogy and A.E. Puente, Springer Pub. Co, N.Y., 2009
Principles of Behavioral and Cognitive Neurology, 2nd ed., M.-Marsel Mesulam. Oxford
University Press, 2000
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Cortical Layers
Plexiform or Molecular -- most superficial
• Mainly plexus of axons & dendrites (synapses)
• Axons to underlying cells
• Dendrites receive impulses from most peripheral areas Small Pyramidal
Cells -- association neurons
• Not clearly separated from medium pyramidal cell layer
• Damage to this cell layer does not disrupt EEG
Medium Pyramidal Cells -- association neurons
Granule layer -- (sharply demarcated)
• Composed of multipolar granule cells Large Pyramidal Cells
• Betz cells in precentral gyrus Fusiform cell layer (efferent)
The part constituting the outer layers of the cerebral hemispheres is called the cerebral
cortex. (cortex means "bark").
Layers I through VI vary in thickness in different cortical regions. Layer IV is most
pronounced in the sensory projection cortex and layer V is most pronounced in the
primary motor cortex (pre-central gyrus). The majority ot cortical neurons travel
vertically through the layers as you will note in the diagram thus the concept of the
(vertical unit organization). Layers II and III are composed on small and medium sized
pyramidal cells and function primarily as association neurons. Layers I and 6b or 7 are
derived from the same tissue as found in the mesencephalon.
General structure of the cortex has a thickness of 4 mm at the precentral gyrus to 1.5 mm
at the visual center Layers: six layers -- two main zones
Outer--receptive--where incoming fibers synapse
Inner--efferent--cell bodies of fibers projecting to other areas
Structure -- vertical units (independent systems which communicate with each other via
association of fibers). The functional unit is a representation of the manner in which
information passes through the nervous system.
General Motor Association
General Sensory Association
<--Cortex
Cortex
V
^
Motor Association Cortex
Sensory Association Cortex
V
^
Motor Strip
Sensory Projection Cortex
V
^
Motor Neuron Pool
Thalamus
V
^
Effectors (muscles & glands)
Receptors
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Layer I: apical dendrites of the pyramidal cells
axons of the stellate cells, tangential to the surface, local intracortical communication
afferent from nonspecific thalamus
Layers II & III:
small pyramidal cells, intercortical information transfer
afferents from nonspecific thalamus
Layer IV:
specific thalamic afferents (terminating on stellate, pyramidal cells
distribution to other layers
Layer V:
large pyramidal cell (giant cells of Betz in the motor ctx)
transfer of information to the subthalamic parts of the brain
Layer VI:
back to the thalamus, corticothalamic projection
The above figure is numbered according to Broadman's areas.
Broadman
NAME
FUNCTION
's #
17
Occipital Lobe
Visual Projection Cortex
18
Visual Association Cortex
19
Posterior Parietal Lobe
Visual Association Cortex
Tempero-pariteal-occipital
37
General Sensory Association Cortex
area
39
Angular Gyrus
Word Recognition
40
Supramarginal Lobe
Somatosensory Association Cortex
1,2,3
Postcentral Gyrus
Somatosensory Projection Cortex
5, 7
Superior Parietal Lobule General Sensory Association Cortex
Middle 1/3 of Superior
41, 42
Auditory Projection Cortex
Temporal Cortex
22
Superior Temporal Gyrus
Auditory Association Cortex
21, 20, 38 Inferior Temporal Cortex General Sensory Association Cortex
4
Precentral Gyrus
Primary Motor Cortex
1,2,3
Postcentral Gyrus
Somatosensory Projection Cortex
6,8,9
Premotor Cortex
Motor Association Cortex
Middle 1/3 of Superior
41, 42
Auditory Projection Cortex
Temporal Cortex
Motor Association Cortex - Specific to
44,45,46
Broca's Area
speech
10
Preftontal Cortex
General Motor Association Cortex
11
Orbital Gyri
General Motor Association Cortex
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The frontal lobes of the human brain comprise all the tissue in front of the central sulcus.
It lies anterior to the central (rolandic) sulcus and superior to the sylvian fissure. This
represents 20% of the neocortex, having three distinct areas; motor, premotor, and
prefrontal. These functionally different areas have been conventially assigned numerical
numbers to represent specific regions (scheme devised by Brodmann). The motor cortex
is area 4, projects to the spinal motor neurons to control limb, hand, foot, and digit
movements and to the appropriate cranial nerve motor neurons to control face
movements. It also projects to other motor neurons such as the basal ganglia and the red
nucleus. The premotor cortex includes areas 6 and 8, which are divided into four areas:
lateral area 6, or premotor cortex; medial area 6, or supplementary motor cortex ( this
area is where the integrity of voluntary movement is controlled); area 8 or the frontal eye
field.
The frontal lobes are considered our emotional control center and home to our
personality. There is no other part of the brain where lesions can cause such a wide
variety of symptoms (Kolb & Wishaw, 1990). The frontal lobes are involved in motor
function, problem solving, spontaneity, memory, language, initiation, judgment, impulse
control, and social and sexual behavior. The frontal lobes are extremely vulnerable to
injury due to their location at the front of the cranium, proximity to the sphenoid wing
and their large size. MRI studies have shown that the frontal area is the most common
region of injury following mild to moderate traumatic brain injury (Levin et al., 1987).
There are important asymmetrical differences in the frontal lobes. The left frontal lobe is
involved in controlling language related movement, whereas the right frontal lobe plays a
role in non-verbal abilities. Some researchers emphasize that this rule is not absolute and
that with many people, both lobes are involved in nearly all behavior.
Disturbance of motor function is typically characterized by loss of fine
movements and strength of the arms, hands and fingers (Kuypers, 1981). Complex chains
of motor movement also seem to be controlled by the frontal lobes (Leonard et al., 1988).
Patients with frontal lobe damage exhibit little spontaneous facial expression, which
points to the role of the frontal lobes in facial expression (Kolb & Milner, 1981). Broca's
Aphasia, or difficulty in speaking, has been associated with frontal damage by Brown
(1972).
An interesting phenomenon of frontal lobe damage is the insignificant effect it
can have on traditional IQ testing. Researchers believe that this may have to do with IQ
tests typically assessing convergent rather than divergent thinking. Frontal lobe damage
seems to have an impact on divergent thinking, or flexibility and problem solving ability.
There is also evidence showing lingering interference with attention and memory even
after good recovery from a TBI (Stuss et al., 1985).
Another area often associated with frontal damage is that of "behavioral
sponteneity." Kolb & Milner (1981) found that individuals with frontal damage displayed
fewer spontaneous facial movements, spoke fewer words (left frontal lesions) or
excessively (right frontal lesions). This is the same as the examples below of a
mesolimbic based EPILEPTIC activity in the right versus left hemisphere.
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behavioral
sponteneity

More Word

Fewer words

Dec FOF Ablative

RB

LB

Inc FOF Epileptic

LB

RB

One of the most common characteristics of frontal lobe damage is difficulty in
interpreting feedback from the environment. Perseverating on a response (Milner, 1964),
risk taking and non-compliance with rules (Miller, 1985), and impaired associated
learning (using external cues to help guide behavior) (Drewe, 1975) are a few examples
of this type of deficit. This could be included in the Right Frontal Hemispheres
association with ATTENTION, NOVELTY, NEW LEARNING.
The frontal lobes are also thought to play a part in our spatial orientation,
including our bodies orientation in space (Semmes et al., 1963). There is a cross-modality
association between the three functional zones: motor cortex, premotor cortex, and
prefrontal cortex. The motor cortex is responsible for making movements, and the
premotor cortex selects the movements which will be initialized. The prefrontal cortex
controls the cognitive processes so that the appropriate movements are selected in
accordance to time and place In the frontal lobes we see the home of our humanism, as
these lobes are not seen in lower animals. The LEFT frontal hemishere can be
characterized as a home of POSITIVE THOUGHT. The RIGHT frontal hemisphere can
be characterized as the home of NEGATIVE THOUGHT.
LESION
physiological or
functional

Depressive
(more negative)

ABLATIVE (dec FOF)

LB

SOMATIC effect
EPILEPTIFORM (inc
FOF)

SOMATIC effect

Manic
(more positive)
RB

Rt sided paresis of Lt sided paresis
Speed, Intiation,
of Speed,
Control
Intiation, Control
RB (mesolimbic)

LB (mesolimbic)

Right sided
Left sided increase
increase tone,
tone, dystonia,
dystonia, spont.
spont. movement
Movement

The major types of mood episodes are either depressive or manic. Below is a comparison
of the direction, reactivity and duration of mood change in characterizing mood episodes:
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Mood

Depressive

Manic

Direction

Sad, blue, dejected

Elated, high, expansive,
euphoric

Reactivity

constricted, blunted,
flattened

labile, exaggerated

Sleep

Allied symptoms
usually insomnia with
early morning
awakenings and
midnight awakenings
(can be hypersomnic in
atypical cases)

Appetite

reduced, often with
weight loss

Libido
Recreation

reduced interest
anhedonic

reduced need for sleep

variable ( can be increased
but can't sit long enough to
eat )
increased interest
increased hedonism

As the affective psychopathology intensifies, the rest of the mental state begins to be
involved. Below is a comparison of the extension of depressive and manic pathology into
the rest of the mental state.
Component of the
mental state

Cognition

Activity

Perception

Depressive

Manic

Feelings of guilt,
expansive, exaggerated
worthlessness,
sense of self, impulsivity,
hopelessness, reduced
overly optimistic,
self-esteem, impaired increased speed of thought
concentration, nihilism, (flight of ideas), poor
negation, suicidal
judgment, grandiosity,
ideation
hyper-religiosity
reduced goal directed
increased activity,
activity, inertia,
pressured speech, spending
psychomotor
sprees, increased risk
retardation, catatonia
taking, manic catatonia
Depressive content,
"body rotting",
may develop frank
somatization, can
psychosis with paranoid
believe everyone is
thought disorder. Can be
against them (paranoia).
virtually identical to
Can have delusions of schizophrenic psychosis
guilt.
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.
1

Frontal Lobes
Motor & higher cognitive functions; Initiative as well as behavioral
inhibition;Sensitivity to social cues
Anatomy
The frontal lobe is heavily interconnected with:
-basal ganglia & other components of the motor system
-all other lobes of cortex
-limbic system
Beyond Motor Planning
Frontal lobe has evolved from being the main motor planner/organizer to a
higher level behavioral/strategic planner/organizer.
Mental model, considering options, selecting behaviors based on context,
feedback, stored knowledge
Making predictions about what will work.
Impaired Divergent Thinking
Decreased consideration of alternative strategies/behaviors; reduced flexibility
Decreased spontaneity, initiative, may appear lazy, unmotivated
Knowledge/intelligence may seem intact (e.g. IQ) but its not used to generate
strategies or solve problems efficiently
Decreased Inhibition
Problems inhibiting incorrect/ineffective responses & switching to a new
strategy
Perseverates; not responsive to feedback or changes in environment
Violates rules, expectancies; takes risks
Not adaptable
Decreased social inhibitons as well
Impaired Associative Learning
Reduced response to consequences
Impaired on delayed response tasks
Impaired responsiveness to social & contextual cues
Decreased Temporal Memory
Impaired memory for order, recency
Could affect problem-solving, planning and impair systematic, organized
behaviors
Possible Personality and Emotional Changes
Apathetic, indifferent, loss of initiative, lack of emotion or somewhat depressed,
little verbal output. Most common after left frontal damage; called
"pseudodepression"
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Possible Personality and Emotional Changes
Lack of tact & restraint, immature, coarse,lack of social graces, inappropriate
sexual behavior, increased motor activity. More common after right frontal
damage; called "pseudopsychopathic"
Some Neuropsych Tests Used
Wisconsin Card Sorting Test
Stoop Test
Chicago/Thurstone Word Fluency Test
Gotman-Milner Design Fluency Test
Visual Search Test
Motor stength, speed and sequencing
.
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FRONTAL LOBE SYNDROMES Human prefrontal cortex syndromes can be subdivided into three subtypes.
A. Orbitofrontal Syndrome - Damage in Brodman areas 11, 12 results in prominent
affect disturbances. Emotional lability and decreased impulse control contribute to poor
social integration. Problems such as loss of control of anger and inappropriate laughing,
crying or sexuality are often observed. Attention capacity is usually preserved, frontal
release signs (i.e. snout, suck, palmomental reflexes) are absent and the patient is
typically aware of the problem but unable to control their reflexive inappropriate
behavior. The most common cause of the orbital syndrome is head trauma with contra
coup damage. Olfactory groove meningiomas can also present with similar complaints.
B. Mesial Syndrome - Bilateral mesial prefrontal damage involving supplementary
motor and cingulate cortex (Brodmann areas 24, 25, 32, 33 and mesila 6, 8, 9) produces
an amotivational, akinetic state with motor programming deficits manifesting clinically
as apractic disturbances. Unilateral mesial or mild bilateral disease yields lesser degrees
of difficulty in the initiation and sustaining of motor and mental activity. A common
cause is anterior cerebral artery infarction due to spasm from subarachnoid hemorrhage.
C. Dorsolateral - Damage in dorsolateral prefrontal cortex (Brodmann areas 6, 68, 9,
10, 44, 45, 46) leads to a complex range of behavioral disturbances since this is the most
advanced phylogentic area in man. In early disease due either to tumors (i.e. glioma) or
degenerative disease (i.e. Picks) sparing language cortex, subtle deficits in creativity and
mental flexibility are often noted by the patient or family. As unilateral disease
progresses or becomes bilateral pronounced behavioral problems become apparent.
Abnormalities emerge in planning, goal directed behavior, temporal coding of external
and internal events, metamemory (i.e. confidence about memory judgments), judgment
and insight. Attention capacity is invariably impaired in advanced disease.
A common cause of acute unilateral dorsolateral prefrontal damage is infarction of the
precentral branch of the middle cerebral artery. This occlusion results in variable amounts
of damage to areas 6, 8, 9, 10, 44, 45, 46. Damage typically centers in area 46 which is
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likely equivalent to the sulcus principalis region in monkeys critical for delayed response
performance.
Acute unilateral infarcts involving area 46 and the frontal eye field (area 8) are often
associated with a transient syndrome of mild global confusion and attention dysfunction.
Right sided prefrontal infarcts are more likely to result in contralateral hemispatial
neglect than comparable volume left sided infarcts. When motor and language cortex is
spared, patients may not seek acute medical treatment. However, when seen at a later
date they may complain of continued problems with attention, memory and mental
quickness. In advanced bilateral dorsolateral disease due to tumor, degenerative or
vascular disease, preservation and frontal release signs (snout, grasp, palmomental) are
often present.
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Premotor Cortex Area 6,8,9
Responsible for kinetic organization of movement once started, transfer, smooth
sequencing. According to Luria, 1973, it is responsible for the conversion of individual
motor impulses into consecutive kinetic melodies.
A. Oral (buccofacial) Praxis
Puff cheeks.
Click teeth together three times.
Whistle,
Protrude tongue
Lick lips.
Pucker lips.
Cough.
Blow out a match.
Retract lips to show teeth.
10. Sip on a straw.
. 2
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B. Speech/Language
Spontaneous speech sample - Note agrammatism and dysprosody.
Diadochokinetic rates - Repeat the syllable "puh" as fast as you can: then "tuh":
then "kuh"; then put thon together "puh-tuh-kuh".
Imitation of monosyllabic and polysyllabic words.
Repeat words of increasing length, i.e. thick, thicker, thickening; zip, zipper,
zippering; and hope, hopeful, hopefully.
Imitation of sentences.
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C. Intransitive Body movements (Motor Sequencing)
Touch fingers with thumb AFAP - reveals paresis, lack of precision, pathological
dystonia, ataxia.
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Separate fingers & bring together AFAP.
Alternately clinch and relax fingers of both hands for a long period of time.
Bilateral clinching & relaxing fingers AFAP.
Finger tapping.
Tapping as fast as possible (Speed)
Tapping two times with one hand and one time with the other hand and then
reversing the pattern (Rhythm). With premotor lesions, movement loses
smoothness and each tap is produced as isolated phenomenon; patient begins to
make superfluous taps or performs identically with both hands.
Snap your fingers.
Salute;
Fist-Ring Test - can't do them in series; more problems when sequence is
reversed.
Fist-Edge-Palm Test .
Circle Hands In Air .

. 2
.
1
1 1
.
1

D. Transitive Body Movements
Demonstrate playing the piano or typing; piano playing test is forward & then
reversed; frontal patients can't reverse; premotor may improve with spoken
commands or feedback; frontals may repeat correctly but can't make proper
movements.
Thread a needle.
Tie shoelaces.
Cut paper with scissors.
Unlock and open a door.
Flip a coin.
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E. Graphics
Write words from dictation - can form letters but often disarranges or transposes
them.
Write sentences from dictation - words may be written correctly but may be in the
wrong order.
Spontaneous writing.
Drawing various shapes,(circle, square, cross)
Draw zig-zag line alternating pointed and rectangular elements.
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Prefrontal Cortex Area 10
Responsible for planning, structuring, and evaluating voluntary (goal directed
behavior, i.e., activities requiring the constant comparison of planned acts with the effects
achieved.
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A. Deficits associated with lesions of the prefrontal cortex
With minor lesions
• Inability to prevent rapid extinction of orienting response following verbal
instruction.
• Disturbances in regulatory role of speech.
• Disturbances in complicated gnostic functions (e.g. understanding
complicated pictures, thematic pictures, comprehension of written text).
• Problem solving difficulties associated with disturbances in selective
organization of mental activity (i.e. serial sevens).
• Deficits in complex tasks requiring inhibition of habitual behavior patterns.
• Difficulties with actions requiring a series of movements, less severe when
accompanied by external verbalization (Fist, edge, palm).
• Difficulties in task executions when instructions or prompts conflict with
what would be expected, although ability to carry out simple instructions is
unimpaired (visual or verbal).
• Difficulties tapping at successive groups of rhythms or drawing a series of
figures that alternate in pattern (tendency to perseverate).
• Decreased spontaneity, decreased rate of behavior, decreased range of
interests, loss of initiative, and impulsiveness without self-corrective action
may be early signs.
• Deficits in visual tracking and scanning, especially on complex tasks.
• Difficulty in constructing mirror-image relationships, especially if complex.
With more extensive lesions.
• Perseveration: difficulties in making behavioral shifts in attention,
movement, and attitude.
• Concreteness & decreased creativity.
• Inflexibility in cognitive, perceptual and motor modalities.
• Poor recall of thematic verbal material (paragraphs).
• Poor recall of verbal & nonverbal series, with contamination of first &
subsequent series.
• Deficits in comprehension of logical-grammatical (prepositional)
constructions (e.g. "place a cross beneath the circle.") .
• Difficulties in writing associated with fatigue, progressively smaller
characters, perseveration, loss of overall plan (i.e. letter transpositions, etc.).
• Deficits in abstract/categorical intellect.
• Take longer to learn go-no go tasks and make more false positive responses
particularly with medial frontal lesions.
• Diminished visual scanning and tracking, resulting in impulsive judgments
which are based on the perception of a single aspect of a stimulus.
• Performance of relatively simple task is impaired by perseveration; however,
overlearned tasks are conducted without difficulty.
• Increased level of distractibility, especially to small noises or events.
• Memory curve plateaus early (approximately 5 items), even with rehearsal.
.
2

42

.
3

• Disturbances in selective memory with confabulation.
• Defects in time sense with respect to recency and time span Judgments and
disturbances of temporal orientation occurring with bilateral frontal lobe
lesions.
• More superior lesions produce motor disturbances, while inferior lesions
produce speech disturbances
• Increased trend toward confabulation .
• Magnitude of deficit is associated with the cause of the lesion (i.e. surgery or
degenerative) and the presence of generalized physical disorders (i.e.
hypertension). Also, deficits are more severe with bilateral involvement.
• Constructive intellectual activity may be distributed when preliminary
analysis and formation of a plan is required (not constructional apraxia per
se) .
• Diminished critical self-evaluation of behaviors; no distress or attempts at
correction.
• Able to perform firmly-established verbal analogies (father: son: Mother, but
difficulty in forming unfamiliar analogies
• Poor capacity for arithmetic tasks involving a series of analytic steps,
although often able to solve simple problems. Tend to make impulsive
judgments.
• Emotional disturbances seen as two principle reactions: inhibition (apathy,
narrowing of interests, flattered affect, withdrawal) and disinhibition
(euphoria, impulsivity, irritability, anxiety, obscene language.
• Symptoms of frontal lobe lesions with increased intracranial pressure can
include headache and somnolence.

.
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With medial orbital lesions
• More often associated with emotional changes such as apathy or
hyperactivity.
• Defects in sorting or abstraction tasks usually not observed; gross intellectual
changes also not apparent.
• Olfactory & visual disturbances may occur.
• Emotional alterations can range from apathy to short-term lability.
Lateral dorsal lesions
• Associated more with intellectual deficits.
• Perseveration is more common: associated with impaired shifting in attention
and thinking.
• With extensive lesions, gross perseveration may occur even though patient
recognizes as inappropriate.
• Impaired categorical thinking apparent.
Left hemisphere prefrontal lesions
• Deficits in tests of categorization and flexibility.
• Problems with body schema (autopagnosia) due to problems of scanning,
perceptual shifting and postural mechanisms.
• Marked inactivity affects general intellectual processes and behavior.
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• Cannot change verbal instructions into acts, especially when the instructions
are complex or symbolic.
• Decreased spontaneity of speech; may result in complete loss of voluntary
speech.
• Memory deficits for verbal material; however, deficits may be due to
defective registration.
Right hemis. prefrontal lesions
• Constructional apraxia, associated with motor rather than perceptual
difficulties; deficits may occur as a function of impaired complex (3-D)
spatial analysis.
• Large lesions may exist without obvious symptoms; serious speech disorders
usually not seen in right hemisphere lesions.
• Difficulty with drawing tasks, though this is associated more with right
hemisphere lesions in general.
• Impaired visual-spatial integration, maze learning, non-verbal visual memory

With very severe lesions there may be a complete disintegration of behavior as
observed in many of the following: nonreactive to environmental cues or instructions
from self to others, reactive to irrelevant stimuli, echolalia, mutism (loss of voluntary
speech), agraphia, confusion, and generalized slowing . * Even though, following the
Luria approach , we have chosen to distinguish lesser from more extensive lesions,
this distinction is somewhat arbitrary. Research suggests that the distinction is based
on quantitative rather than qualitative differences. That is, with lesser lesions, one
could expect to find deficits similar to those seen in cases of more extensive lesions;
however, such deficits would obviously he of less magnitude. Likewise, the types of
deficits associated with less extensive lesions would undoubtedly be observed in more
extensive cases.
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B. Tests - Prefrontal Lobe Function
Wisconsin Card Sort: left > right
Word fluency: L > R
Halstead Categories Test: L > R
Trail Making, Part B: L > R
Color and word page of Stroop Color and Word Test: L > R
Temporal orientation test: bilateral
Verbal associative learning: bilateral
Personal identification test(body schema): L>R
Picture Arrangement: R > L
Memory for Designs: R > L
3-D Constructional praxis test: R > L
Object classification test: Right frontal and left parietal
Link's cubes (building a large cube from differently colored small cubes): R > L
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Reaction of choice tests (two choices), such as go-no go: L > R on more complex
tasks.
Impairment on tests requiring complex picture and Raven's Progressive Matrices)
Depressed digit span: L > R.

Supplementary Motor Area
The supplementary motor area (SMA) occupies an expanse of frontal agranular
cortex rostral to the primary motor cortex (MI), largely in the medial surface of the
hemisphere. It is basically organized topographically, although the topography is
not as apparent as in the MI. The traditionally defined SMA is now regarded as
including two separate areas.
The caudal part (SMA proper or F3) projects directly to the MI and to the spinal
cord.
The rostral part (pre-SMA or F6) is more remote from MI and receive projections
from the prefrontal cortex and the cingulate motor areas.
The supplementary eye field (SEF) is a small area separate from either the SMA or
pre-SMA. The SEF is connected to cortical and subcortical areas related to
oculomotor control. The SMA is active when subjects perform distal as well as
proximal limb movement. The SMA activity is subject to functional plasticity. The
SMA is more active than the primary motor cortex if motor tasks are demanding in
certain respects. Similarities of lesion effects of the SMA and basal ganglia
suggests their intimate relation linked anatomically by the cortico-basal ganglia
loops.
Studies in both human subjects and in subhuman primates indicate the importance
of the SMA in motor tasks that demand retrieval of motor memory. The SMA
appears also crucial in temporal organization of movements, especially in
sequential performance of multiple movements.
Transcortical motor aphasia - The lesion is anterior to Broca's area or in the
supplementary motor area. The language syndrome is similar to Broca's except for
preserved repetition and occasionally preserved writing.
Language is a motoric component, therefore, we should become a bit more adpet at
noticing subtle changes in cadence, prosadic variation, mistakes. Etc.
Broca's Aphasia (= nonfluent = expressive = motor = anterior aphasia) - Broca's aphasia
is seen in its pure form in lesions involving the inferior frontal gyrus. Due to the
proximity of the precentral gyrus, there is typically an associated right central facial
paresis and right hemiparesis (arm>leg). Speech is slow, effortful, and has articulatory
errors. Phrase length varies from complete mutism to decreased number of words per
sentence (2-3 with normal being 5-9). There is a parallel deficit in writing. Repetition,
particularly short phrases ("no ifs, ands or buts")is severely disrupted. Comprehension is
largely intact although detailed linguistic analysis reveals difficulty with prepositions
such as into, on, etc. There is often associated anomia, production of paraphasic errors
("grish" for "dish") and oral facial apraxia. The apraxia is manifested by difficulty in
sequencing oral movements. Patients may be able to hum a tune or sing words.
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Anterior Temporal Cortex
Performs basic Auditory processing of auditory stimuli that are shorter in duration than
similar stimuli processed more posteriorly in the temporal lobe. Also processes some
visual material.
A. Dysfunctions Associated with Lesions of Anterior Temporal Lobes
Auditory memory disturbance
Left anterior temporal lobe damage impairs learning and retention of verbal
material regardless of whether material is auditorily or visually presented and
regardless of whether patient is tested using recall or recognition techniques.
Left anterior temporal lobe does not affect memory for places, faces, melodies- etc.
Right anterior temporal lobe damage impairs recognition and recall of visual and
auditory patterns that do not lend themselves to verbal coding.
Difficulty remembering short auditory stimulation.
Deja vu.
Hallucinations (auditory and/or visual).
Disinhibited social behavior.
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B. Assessment Strategies for Anterior Temporal Lobe Lesions
Paired associates
Seashore Rhythm Test
Left vs. right
• -Paired Associates Verbal Story for Immediate Recall
• Visual Memory
Seashore Rhythm Test
Visual Memory
Seashore Rhythm Test
Repeat short and long sentences
Discern presence of deja vu. Presence of deja vu does not help to lateralize lesion .
Discern presence and nature of hallucinations
Obtain recent history concerning quality of social judgment
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Middle Temporal Lobe
General association cortex integrating input from lower level auditory and visual areas.
A. Dysfunctions Associated with Lesions of Middle Temporal Lobe
Acoustico-mnestic disorders, can't retain series of sounds, syllables or words in
memory.
• Comprehension of individual words intact but cannot retain more than 2 or 3
at once.
• In mild cases, patient can retain essential elements of series but cannot
remember correct order.
• Problem is due to increased mutual inhibition of auditory traces.
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Do not have difficulty with phonemic learning.
Difficulty reproducing words or word series under complicated conditions.
Impaired ability to name series of objects.
Stimulation gives hallucinations, memory images, changes in state of
consciousness.
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B. Assessment Strategies for Middle Temporal Lobe
Paired associates, long vs. short series of words, verbal story for immediate recall.
• Check for comprehension of individual words in above tests.
• If items are remembered, check for proper ordering.
• Increase intervals between presentation of individual items in series and see if
performance improves.
Auditory Discrimination Test
Introduce a distraction interval before patient repeats series.
Ask to name several objects individually and then all at once.
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Right Temporal Cortex
A. Effects of lesions-temporal cortex
Compared with similar lesions of the left temporal lobe, right temporal lesion
effects tend to be notable statistically but of less clinical significance.
Visual analysis (nonverbal primarily)
• Impairment of simple and complex visual analysis, but some negative
findings.
• Impairment of short-term nonverbal memory.
• Impaired perception of tachistoscopically-presented letters.
• Prosopoagnosia (especially with anterior lesions).
• Impaired recognition of objects seen from unusual angles.
3. Auditory analysis (nonverbal)
• Impairment of short-term auditory memory.
• Perception of short sounds impaired.
• Impaired recognition of familiar sounds.
• Impaired tonal discriminations, timbre discriminations, and amplitude
discriminations.
• Amusia.
• Impairment of contralateral ear input in dichotic listening.
.4. Constructional tasks
• Visual construction impairment proportional to tissue loss.
• Impairment in maze learning (visual and proprioceptive feedback).
• Enlarged left-hand margin in dictation.
Psychiatric -- personality phenomena with right temporal epilepsy
• Personality changes.
.
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• Psychiatric symptoms.
• Deja vue.
• Metamorphopasias.
Psychometric findings
• Temporary decline in Performance IQ following lobectomy.
• Impairment on WAIS Picture Arrangement.
• Impairment on Binet Memory for Designs
• Possible impairment of WAIS Block Design?.
Persistence in maintaining a hypothesis even after being informed it was not
correct.
B. Assessing possible right temporal lesions
Impairment on WAIS Picture Arrangement.
Impairment on Seashore Test of Musical Talent (especially Tonal memory, Timbre,
Loudness, and Time).
Lezak and others
• Have the patient identify a tune the examiner hums. If unsuccessful, try
several other familiar melodies to check for amusia.
• Test pitch discrimination with pitch pipe.
• Have patient try to discriminate (or imitate) different rhythmic tapping
patterns. A memory component may be added.
• Test recognition of familiar sounds.
• The examiner may pair verbal and nonverbal material to clarify the
interpretation of a patient's failures.
Dichotic thresholds.
Impairment of short-term memory for other nonverbal acoustic tasks.
Visual recognition deficits (prosopoagnosia included)
• Impairment of recognition of photographs of faces.
• Impairment on Closure Faces Test (Mooney).
• Impairment on McGill Picture Anomalies Test.
• Difficulty in identifying pictures of objects viewed from unusual angles.
Impairment of other nonverbal visual tests of short-term memory and visual
discrimination or Binet Memory for Designs Test.
Corsi's block-tapping test.
Impairment on stylus maze tasks (visual or proprioceptive feedback).
Impairment in enumeration of tachistiscopically-presented dots.
Enlarged left margins in dictation.
In epileptics a history of strong deja vue experiences or metamorphopsia.
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Left Temporal
Primary functions of this lobe include: decoding of speech sounds, comprehension of
speech and mediating verbal memory processes.
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A. Dysfunctions associated with lesions of the left temporal lobe.
Auditory deficits (right ear)
• Intracranial localization of sound is impaired.
• Increased threshold for perception of short bursts of sound.
• Increased threshold for some frequencies.
• Failure to perceive brief simultaneous auditory stimulation.
Visual deficit (both eyes)
• Upper right quadrantanopsia.
Other complex sensory deficits
• Right hand tactile performance difficulty.
• Right hand finger agnosia.
Language deficits
• Decoding of speech sounds (phonemes) is impaired.
• Problems with verbal repetition.
• Problems with auditory comprehension of speech.
• Receptive aphasia (deficits in all language qualities).
• Impairment of dichotic listening to verbal material.
• Intellectual impairment on verbally mediated intellectual processes.
Memory impaired for verbal material.
Impairment on measures of higher cortical functions (Trails A and Trails B).
Emotional disturbances
• Perceptual distortions, alterations of mood, obsessional thinking, psychosis,
temper outbursts, hypo and hypersexuality.
B. Assessment devises for left temporal lobe lesions
Auditory tasks
• Binaural localization of clicks.
• Simultaneous auditory messages.
• Short duration tone bursts-threshold testing.
• Frequency threshold testing.
• Dichotic listening.
Visual testing
• Test visual perimetry.
Complex sensory tests
• Tactual performance test.
• Finger agnosia test.
Linguistic abilities tests
• Speech sound perception test.
• K-V auditory discrimination test.
• Token test (for comprehension).
• Aphasia exams
• Wepman-Reitan Aphasia Screening Test.
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• Porch Index of Communicative Ability.
• Boston Diagnostic Aphasia Examination.
• Dichotic listening.
Measures of Intelligence
• Wechsler Adult Intelligence Scale; sensitive subtests include similarities,
arithmetic, and digit symbol.
Assessment of verbal memory
• Hebb's recurring digits (digit span with every third list is repeated).
• Consonant trigrams (recall of a spoken set of three consonants following
distraction).
• Discrimination of recency (subject required to indicate which of two verbal
stimuli they have seen most recently).
• Recall of Logical Memory from Wechsler Memory Scale after a 1 hour
delay.
7. Assessment of higher cortical functions
• Trails A and Trails C.
8. Emotional disturbances
• MMPI.
.
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Wernicke's Area
A region of the brain located in the posterior, superior temporal gyrus, adjacent to
the cortical region for hearing. This area seems to be of focal importance for language
and is involved in the recognition of the auditory patterns of language.
Wernicke's Aphasia (= fluent = receptive = sensory = posterior) The lesion is in the
posterior region of the planum temporale of the superior temporal gyrus (Wernicke's
area) and adjacent inferior parietal cortex. Motor weakness is typically minimal or absent.
There may be a partial hemianopsia due to involvement of the geniculocalcarine fibers
deep to this area. Word output is normal or increased, with many paraphasic errors, and
speech is often incomprehensible (jargon aphasia). Paraphasic errors include elogisms
("Slep", "gort"), phonetic distortions ("good" for "wood") and semantic mistakes (Chevy
for Ford). Auditory (speech) and visual (reading) comprehension are severely disturbed.
The patient cannot follow 2 or 3 part commands (i.e. pick up the pen and give the keys to
the doctor). One part commands can often be followed (i.e. stand up). Repetition is
impossible. The severe comprehension disorder often makes testing of other cognitive
functions difficult.
.
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A. Dysfunctions
Speech may be very rapid, with rhythm, grammar and articulation preserved, but
devoid of content.
The patient may fail to use the correct word and substitute circumlocutory phrases
and "empty words" (e.g.,"thing").
Verbal paraphasia -- substitution of one word or phrase for another, sometimes
related in meaning
.
2
.
3

50
.
4
.
5

Literal (phonemic) aphasia -- substitution of incorrect sounds in otherwise correct
words.
A lesion in Wernicke's Area can produce a severe loss of understanding, even
though hearing of nonverbal sounds and music may be fully normal.
Damage to Wernicke's Area causes difficulties in the comprehension of both
spoken and written language since auditory pattern can't be aroused
Disturbance of auditory analysis and syntheses which leads to the loss of phonemic
hearing.
Impaired ability to match an auditorily presented word to its equivalent picture
when presented in an array of phonemically similar test items.
Normal articulation, prosody and average phrase-length; rate of speaking normal or
increased; frequent verbal neologistic or unclassifiable paraphasias; periods of
jargon and severe disturbance in verbal comprehension.
Word-comprehension disorders.
A case in which a right-handed male with a completely destroyed Wernicke's
Area in the left hemisphere, did not result in aphasia. This case is first validated
case of language dominance in the right hemisphere of a right-handed individual.
Impairment in the comprehension of language and associated mental decrement.
Disruption of the ability to obtain meaning from a stimulus and to use it as a basis
for orderly symbol formation.
Impaired naming repetition, and comprehension in the presence of fluent speech.
The speech pattern is markedly circumlocutory and void of specific semantic
content. Production of neologistic jargon is also observed.
Disturbances in reading, writing, naming, repetition, and comprehension of the
spoken language
A patient, though his hearing is normal, is unable to understand spoken speech.
Perseveration may occur, in which the same word is used repeatedly.
Accelerated speech may be one of the factors which leads to perseveration and
lack of inhibition may be another.
Disturbance of the understanding of speech, defects in the repetition of words and
the naming of objects, impairment in writing.
Patients displaying breakdown in the discrimination of speech sounds and
consequent difficulties in the comprehension of speech and of word meanings, but
without impairment of hearing per se, are most likely to have lesions in Wernicke's
Area.
Comprehension deficit attributed to a selective impairment in phonological
perception.
Proper auditory feedback is absent.
A Lesion in "the centre of auditory images" gives the classical Wernicke's aphasia
(fluent speech, poor comprehension, and poor reception)
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A lesion which interrupts the pathway from the primary auditory area to
Wernicke's Area produces "pure word deafness." The patient has fluent and normal
spontaneous speech but he cannot comprehend or repeat spoken language.
Although he can comprehend written language and read aloud.
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B. Tests for Aphasia
Porch Index of Communicative Ability (PICA)
Token Test
Token Test (3E-item version)
• Appears to be a useful and convenient device to diagnose aphasia impairment
of language comprehension.
Boston Diagnostic Aphasia Battery
Western Aphasia Battery
Minnesota Test for Differential Diagnosis of Aphasia
Halstead-Wepman Aphasia Screening Test
Head's Serial Tests
Language Modalities Test
Illinois Test of Psycholinguistic Abilities
Michigan Picture Language Inventory
Functional Communication Profile
Examining for Aphasia
Sklar Aphasia Scale
Neurosensory Center Comprehensive Examination for Aphasia
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MEMORY - Memory the ability to store and retrieve information both on a short and
long term basis. It is a critical factor in all forms of learning. Memory dysfunction is an
early feature of numerous neurological disorders. In addition, it is a frequent complaint in
psychotic patients. When valuating a patient's memory function, it is important to
remember that inattention, decreased motivation and poor cooperation, all features of
non-organic depression, can appear to decrease memory ability. In depression, however,
the memory defect can be overcome by eliciting the patient's cooperation and
concentration, while organic deficits in memory are not removed by increased patient
effort.
Temporal Stages of Memory:
1. Sensory Store - From stimulus onset to about 250 msec. This is the stage during which
a sensory input is converted into a perceived sensation.
2. Short Term Memory (STM) - This refers to a system which holds new sensory traces
from a few seconds up to 1-2 min. If the information is of interest or requires more
processing it is rehearsed (recycled) in STM or transferred to long term memory (LTM);
if not, it is forgotten. STM is a limited capacity, modality -specific system; (i.e. may not
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be able to hold any more auditory input in STM, but could add additional visual input).
Clinical disorders of memory are not defects in sensory store or STM. Patients can
usually store items for 15-45 seconds even with the most severe degree of anterograde
memory loss. If the sensory store or STM is impaired it is usually due to an attentional
disturbance. This can be assessed by digit span test. Memory disorders involve transfer of
information from STM to LTM.
3. Long Term Memory - Formation of LTM requires both intact sensory store, short term
memory and the consolidation mechanism which takes new data from short term store
and converts it into LTM. Most clinical memory deficits involve breakdown in
conversion from STM to LTM. This deficit is referred to as anterograde amnesia or the
inability to form new LTM. Once information has been stored in LTM it can still decay if
not rehearsed (recycled through STM?). Not all new facts that you learn and remember at
the end of a day are present weeks or months later. LTM is the last memory to be lost in
organic disease, with the most remote events (i.e. childhood events) remembered the
longest. The loss of remote memory is referred to as retrograde amnesia. It is always
accompanied by severe anterograde amnesia.
4. Neuroanatomy of Memory - The hippocampus plays an essential role in the transfer of
memories from STM to LTM. Recent data suggest that critical structures in STM-LTM
conversion include the hippocampus and the nearby temporal stem which contains fibers
connecting the middle and inferior temporal gyri with the dorsomedial nucleus of the
thalamus.
Lesions of the dorsomedial nucleus of the thalamus (which projects to orbitofrontal and temporal cortex), mammillary bodies (which project to anterior nucleus of
thalamus, then to cingulate gyrus), fornix, and entorhinal cortex also cause memory
disturbance. Of interest is the finding that unilateral lesions of any of these structures
cause relatively minimal clinical deficit; bilateral lesions are needed for severe deficits in
memory function.
PARIETAL LOBE SYNDROMES - The left and right parietal lobes have equal
processing capabilities for light touch, tactile localization, 2-point discrimination, joint
position sense, passive movement sense, and stereo gnosis. Lesions in the post-central
gyrus or adjacent parietal cortex impair these functions. The remaining areas of parietal
lobe are involved in complex trimodal associations which are lateralized. Language and
sequential analysis ability are strongly lateralized to the left inferior parietal lobe and
adjacent superior temporal plane (see aphasia). Spatial abilities are 1Q86 strongly
lateralized than language. Both parietal lobes have substantial spatial abilities, with the
right being superior. Disorders of spatial-perceptual abilities are seen with the highest
frequency in right parietal association cortex lesions.
A. Right Parietal Lobe Syndrome:
1. Constructional apraxia is manifested by deficits in block design, stick design, drawing
and geometric design. Patients tend to focus on individual elements (local properties) and
lose the overall picture (global properties). This deficit extends to geographical space
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disorientation.
2. The hemi-inattention or hemi-neglect syndrome is the most dramatic non- dominant
hemispheric syndrome and is seen in cortical lesions involving the temporal-parietal
junction or the frontal eye field. Neglect can also be seen in unilateral thalamic lesions.
The patient shows neglect of the contralateral half of visual space, the most severe
example being anosognosia or denial of illness. Patients may deny having hemiplegia and
may even deny the hemiparetic arm is theirs. Mild forms include extinction of the
contralateral (left) stimulus during simultaneous presentation of bilateral visual, tactile or
auditory stimuli.
3. Dressing apraxia - The patient has difficulty dressing the left side of body.
B. Left Parietal Lobe Syndrome:
1. Gerstmann Syndrome: acalculia, finger agnosia, left/right disorientation, agraphia. The
lesion is in the left angular gyrus. Since there is often some degree of receptive aphasia
and anomia, some features may be due to language disturbance.
2. Fluent aphasia, due to lesions of the temporal/parietal junction (i.e. Wernicke's,
conduction, see Aphasic Disorders).
3. Alexia with agraphia can occur with angular gyrus lesions; some cases produce profuse
semantic errors (i.e. deep dyslexia).
4. There are less severe deficits in constructional ability and milder forms of hemiinattention to contralateral space.
C. Bilateral Parietal Syndrome:
1. Simultagnosia - The patient sees only one section of the visual field and fails to
perceive the rest, although formal visual fields are normal on tangent screen perimetry.
The patient may not be able to recognize large objects and will have to grope around the
room.
2. Visual Agnosia - This involves a bilateral occipital/parietal lesion. The patient cannot
name an object and cannot tell what it is or describe what it is used for. However, the
patient can visually describe the object. There is a disconnection of visual information
from memory stores. The patient knows and can name the object as soon as it is touched.
Post Central Gyrus
This is the primary projection area for somatosensory and kinesth-etic/proprioceptive
inputs. It is topographically organized, and important body areas for tactile analysis
(hands, face, mouth, tongue) receive disproportionate representation. The sensory
feedback loops that project into this region are intimately related to precise motor control
as well. Thus, both sensory and motor impairment are possible sequelae of injury to the
post central gyrus.
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A. Kinesthetic Basis of Movement
Eyes closed - patient is to position hand to match position of other.
Passive finger detection.
Two point threshold.
Von Frey Hair threshold.
Vibration sense.
With lesion most severe changes are distal, coarse sensations return first.
Height discrimination.
Pinpoint vs. head.
Touch area on skin, have patient point to area on contralateral side.
Fasten a button.
Tie a shoelace.
Localized lesion by deficit interactions.
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B. Post Central Gyrus Test Items:
Eyes closed - match one hand to position set by examiner. Used in "Luria Battery".
Passive finger detection, two point threshold, Von Frey Hairs Finger Agnosia used in Halstead Reitan Battery In-Between test, two point finger test, matchbox
test, finger-tip number writing, Rey's skin writing.
Vibration sense - tuning fork.
Weight discrimination.
Pinpoint vs. head - use a pin. Also see Talland, 1965 - cited in. Tactile Completion
Test.
Touch area and have patient point to contralateral area.
Fine motor tasks - see also Grooved pegboard, motor steadiness, finger or stylus
mazes.
Not on outline, but also look for unusual speech. Consonant substitutions
(especially of similar sounds), without broken or jerky speech typical of Broca's
Aphasia. May see writing errors due to role of articulatory movements in analysis
of words.
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Most tasks for assessing the integrity of this brain area are more neurological than
psychometric in nature.
Inferior Parietal Lobule
A. Dysfunctions caused by lesions
1. Apraxia for dressing.
2. Constructional apraxia (spatial apraxagnosia) - problems in motor integration in
constructional tasks.
3. Spatial orientation deficit (more severe for right hemisphere lesions than left:).
4. Right-left disorientation.
5. Planto-pokinesia (disorganization of discriminations in spatial Judgment).

55
6. Visuospatial agnosia.
7. Difficulty in performing reversible operations in extrapersonal space (difficulty
in taking different perspectives) (more severe for right hemisphere lesions than
left).
8. Inability to maintain visual image of patterned and verbal material.
9. Visuographic defects.
10. Unilateral neglect.
11. General intellectual impairment (lesions in left hemisphere).
12. Problems with writing and defective comprehension in reading.
B. Assessment
1. Inability to analyze positions of hands on a clock.
2. Confuses symmetrically arranged symbols (e.g., d & b).
3. Difficulty making rotations on a 2-D stick test.
4. Difficulty changing perspectives on a village scene test.
5. Difficulty with transformations on pool reflections test.
6. Problems on both visual and tactile route finding tests.
7. Difficulty in maze learning.
8. Inability to follow habitual routes.
9. Difficulty designating body parts on examiner.
10. Difficulty drawing common objects to demand.
11. Problems in visual memory for patterns and verbal matter.
12. Errors on the Bender.
13. Poor performance on Unknown Faces Test
14. Difficulty with simple addition, subtraction, multiplication, and division, both
presented orally and written.
15. WAIS arithmetic subtest scores lowered.
16. Low test scores on Army General Classification Test.
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Supramarginal Gyrus
A. This sensory association area integrates kinesthetic memories with auditory
commands. Lesions may produce:
Ideomotor apraxia: disruption of organization of complex acts
• Results from left hemisphere lesion
• Usually affects both sides, may be worse on right side
• Can affect the face (buccofacial) and/or the limbs
Conduction aphasia: results from left hemisphere lesion if the underlying arcuate
fasciculus is cut
• Severely defective repetition
• Paraphasia in repetition and in spontaneous speech
• Normal comprehension
• Impaired writing, spontaneous and to dictation, errors in spelling, word
choice, syntax
Astereognosis: impairment of somatosensory discrimination
• Left hemisphere lesion: both hands affected
• Right hemisphere lesion: deficit - left hand
.
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Finger agnosia: inability to recognize, name, and point to individual fingers on self
and others (left hemisphere lesion).
Right-left disorientation
• Can't distinguish right from left on self or env.
• More common with left hemisphere lesion
Acalculia
• Loss of ability to understand & order numbers
• More severe with left hemisphere lesion
Tactile perceptual disability: results from contralateral lesion
Gerstmann's syndrome: Researchers disagree as to the lesion site for this syndrome,
but the supramarginal and/or angular gyrus is usually involved. This left
hemisphere, inferior parietal disorder includes:
• Right-left disorientation
• Finger agnosia
• Agraphia
• Acalculia
Lesion of right hemisphere supramarginal gyrus can cause:
• Constructional apraxia
• Mild left side neglect and/or denial
• Inability to interpret maps
B. Tests to measure the Above Deficits
Ideomotor apraxia
• Carrying out motor acts to command: buccofacial (blow out a match,
protrude tongue, drink through a straw)
• Carrying out motor acts to command: limb (salute, use a toothbrush, flip a
coin, hammer a nail, comb hair, snap fingers, kick a ball, crush out a
cigarette)
Conduction aphasia
• Repetition of words, phrases, & sentences
• Write to dictation (letters, words, sentences)
• Ask patient to write sentences describing a Job, the weather, or a picture
• Confrontation naming of objects, clothing, body parts, parts of objects
Astereognosis (with eyes closed)
• Patient identifies by touch such common objects as a coin, paperclip, pencil,
or key (each hand tested separately)
• Patient judges the relative size of a series of coins
• Patient judges the texture of a series of objects, such as cloth, wire, sandpaper
Finger agnosia
• In-between test, Two-Point Finger Test, and Match Box Test
• Identifying named fingers on examiner's hands and naming fingers on self
Right-left disorientation
• Identification of right and left limbs on self and examiner
.
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• Crossed commands on self and examiner
Acalculia
• Written addition, subtraction, multiplication, and division problems
• Verbal complex problems
Fingertip number writing
Gerstmann's syndrome
• Right-left disorientation
• Finger agnosia
• Agraphia: writing to dictation and writing sentences describing scenes in
pictures
• Acalculia
Lesions of right hemisphere supramarginal gyrus
• Constructional apraxia
• copying designs
• match stick tests
• block construction test
• Left-side neglect
• glove test: ask the patient to put on a pair of gloves
• drawing to command: clock, bicycle, flower in pot
• behavioral observations
• Have patient locate cities on a map
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Parieto-occipital Cortex
A. Right hemisphere - intact functioning of this area of the cortex contributes to the
individual's ability to orient himself in space, reproduce constructions, and recognize
objects through visual or tactile cues. Facial recognition appears to be a function of right
parietal cortex as well.
Dysfunction may produce:
Right-left homonymous hemianopsia - severe visual field cuts. Test: visual exam,
copy drawings, reading ability.
Contralateral hemianaesthesia - global anesthesia to all modalities affecting the left
side of the body, but with grossly preserved motor and postural control of the
involved limbs.
Paragnosia - difficulty with visual recognition of objects - also called visual
agnosia. Test: Naming tasks, visual recognition tasks.
Prosopagnosia - recognition of faces. Test: Tachistoscopic recognition of faces,
behavioral observation.
Spatial loss greater than with lesion to left hemisphere. Test: constructional ability
tests.
Unilateral spatial agnosia - neglect or inattention to one side in spatial orientation.
Test: Drawings of designs, block design, Incomplete Pictures.
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Visuospatial Dysgnosia - loss of "whereness", relation of self to environment and
relations of objects to each other. Test: Drawings of designs, loss of way in familiar
surroundings, tests of right-left orientation.
Anosognosia - lack of awareness of defect.
Test: Self-report by patient-interview.
OCCIPITAL LOBE SYNDROMES
A. Isolated area 17 lesion - contralateral hemianopsia, often with macular sparing.
Patients with isolated, unilateral area 17 lesions have been shown to differentiate X
from 0, detect grating patterns, and reach accurately for objects in their blind field.
These visual capacities in "blind" fields may reflect extrageniculocalcarine
connections between pulvinar, superior colliculus or accessory optic tract with
visual association cortex areas 18 and 19. There may also be some involvement of
uncrossed non-classical visual projection system.
B. Bilateral area 17 lesions - This results in cortical blindness with pupillary
reflexes spared and no optic atrophy. The patient may be able to tell if a light is
turned on or off and may perceive some form and movement. Form is often
reported as shades of gray.
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Occipital Lobes Area 17
Deficits associated with lesions
• Homonymous hemaniopsia of contralateral visual field follows unilateral
lesion; scotoma, or "blind spot" follows subtotal lesion.
• Amblyopias, areas of intermediate degree of change in visual function, are
often found near scotomas
• A field defect may be reported as blindness in the eye on that side.
• Some loss of visual function may occur in intact half fields in homonymous
hemianopsia.
• Central scotomas may lead to subjectively normal visual fields with reduced
acuity.
• Macular sparing may occur if the lesion is close to the occipital pole.
• Bilateral ablation may result in "cortical blindness" (inability to see, with
denial and confabulation, sometimes called Anton's syndrome), or to subtotal
blindness with residual ability to discriminate luminous flux and a speckled
from a grey field.
• Interruption of optic pathways may produce similar, but not always identical
symptoms to lesions of area 17.
• Acute trauma may cause warping of visual coordinates, distortions, and
polyopias. These symptoms may disappear within days or last for months.
They may reappear ictally
• Toxic states may produce transitions from visual distortion to blindness and
back again.
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• Eye movement may be affected differentially by right or left occipital lesions;
left lesions will shift to compensate for a scotoma while right lesions may not
follow in the area of the scotoma.
• Left occipital lesions with involvement of the splenium of the corpus
callosum may result in alexia without agraphia.
• Focal seizures consisting of visual sensations have been associated with
lesions found in area 17
Tests for dysfunction
• Perimetry allows definition of limits of scotoma. Harms perimeter allows
definition in terms of contour, spectral values, intensity, as well as critical
flicker frequency.
• Amblyopias may also be tested with Harms perimeter; deficits are found in
critical flicker frequency, dark adaptation, and two point resolution
• Homonymous hemianopsia indicates cortical lesion or interruption of optic
radiations, while bitemporal hemianopsia indicates interruption of the optic
pathway at the optic chiasm. Monocular blindness results from unilateral
destruction peripheral to the chiasm, and quadrantonopsia from selective
interruption of the radiation fibers in one hemisphere, either temporal or nasal
but not both.
• Macular sparing indicates that the lesion involves the occipital cortex, rather
than the optic radiations. Occlusion of the posterior cerebral artery should be
suspected.
• "Filling in" of a scotoma may be tested by presentation of a horizontal line
crossing the visual field with a gap in the scotomatous area. Patients report
seeing a completed line if filling in occurs
• Eye movement can be tested by having the patient follow a moving target.
Occipital lobe and posterior occulomotor lesion patients can do this; frontal
lobe or anterior ocularmotor lesion patients cannot follow the verbal
command with voluntary following. Right occipital lesions will not follow
into the left half field.
• Forced choice (guessing) discrimination of a stimulus may result in
identification of objects within a scotoma, although if asked to identify a
stimulus the patient reports he does not see it.

Areas 18 and 19
•
•
•
•

Deficits associated with lesions
Visual recognition (agnosia) may result from bilateral lesions since visual
input is disconnected from other sensory association areas.
Reading is affected if visual input does not have access to left inferior parietal
areas
In man selective lesions of 18 and 19 do not take place. Some temporal or
parietal involvement always occurs.
Limited unilateral ablation may product deficits in visual following.
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• A unilateral (usually right) lesion (especially with parietal involvement)
results in unilateral spatial agnosia since eye movements fail to compensate
for the lost left visual field.
• The degree of deficit is related to the extent of the lesion, i.e., how much
parietal or temporal involvement.
Tests for dysfunction
• Sensory deficits such as rapid visual fatigue, impaired visual adaptation, and
raised visual thresholds indicate involvement of 18 or 19.
• Visual following is tested by looking for opticokinetic nystagmus generated
by following moving vertical black lines on a white background.
• Unilateral spatial agnosia is tested by picture copying (details on the left may
be omitted) or card sorting (cards on the left are ignored).
• Tests for degree of bilateral deficit may be done in order from simplest to
most complex: identification of clearly drawn pictures, identification of
complex or indistinct pictures, identification of scribbled-on pictures,
identification of hidden structures or Raven's Progressive Matrices Test.
C. Types of Visual Agnosias
Visual agnosia: an associative visual deficit in which perception and acuity are
relatively normal, while the recognition and meaning of the percept are absent. This
deficit is generally associated with lesions in the occipitoparietal and occipitotemporal
region of the right hemisphere. Recently it has been postulated that bilateral lesions of
the inferior longitudinal fasciculi interrupt the transfer of visual information from the
occipital lobe to the temporal lobe and the limbic system, permitting processing for
perception, but not for meaning, and producing the necessary and sufficient conditions
for this syndrome. However, since the different types of visual agnosia sometimes
occur dissociatively, others hypothesize discrete, although contiguous, pathways for
interpreting visual stimuli, reading, identifying familiar faces, and color naming.
Visual object agnosia-a deficit in which visual perception is intact, but recognition and
ascription of meaning to objects seen is impaired.
• This defect is associated with a right occipitoparietal lesion although similar
left hemisphere lesions are frequently present.
• Test-naming of simple objects and pictures, naming of complex or
ambiguous pictures, locating visual stimuli with interference or with pictures
superimposed on each other, fragmented letters, the Benton Visual Retention
Test, and WAIS Object Assembly.
Prosopagnosia-the inability to recognize familiar faces. This is a special type of visual
object agnosia and often occurs with other visual agnosias.
• It is most frequently seen with right occipitoparietal and occipitotemporal
lesions.
• Test-matching of facial pictures and identification of famous faces
Color agnosia-a defect of color recognition which has a variety of forms, primarily an
inability to name or discriminate between colors. The color name may be given in a
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qualified or concrete form or a confabulation may occur. It sometimes accompanies
alexia and aphasia.
• Usually results from a left occipital or occipitotemporal lesion.
• Test-matching names to colors and colors to names, color sorting, arranging
shades of a color by intensity, coloring pictures appropriately, identification
of inappropriately colored objects.
Simultanagnosia-the inability to absorb more than one object or aspect of a visual
stimulus at a time.
• This condition occurs with bilateral lesions of the occipitoparietal region.
• When accompanied by incoordination of ocular movements, this defect is
known as Balint's syndrome. Test-have patient attempt to draw a line around
shapes (circle, square, triangle), or write with eyes open, then closed (with
Balint's syndrome, closing eyes improves handwriting).
Metamorphopsia-objects are correctly recognized but are subjectively distorted.
Variations-include alterations in object size or in the obliquity of vertical and
horizontal components, inversions of objects, waviness or fragmentation of lines,
and apparent movement of stationary objects or their contours. In other variations,
objects may appear alien or unusually familiar, very sinister or very beautiful, or
endowed with special personal meaning.
• Lesions of the occipital lobe produce simpler deficits, while parietal lesions
tend to produce intermediate effects, and temporal lesions are associated with
more complex disorders.
• Teleopsia objects appear small and at a distance
• Pelopsia objects appear to loom up close
• Loss of stereoscopic vision
• Palinopsia (paliopsia) -- perseveratory illusions which are superimposed upon
objects currently in the visual field. This defect usually occurs in the presence
of a right occipitotemporal lesion.
• Test-assess qualitative visual changes via patient report and tasks tapping
visual disorientation, inattention, fluctuation, delayed recognition of forms,
imperfect synthesis of moving objects, and altered rate of flicker-fusion.
.
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D. Integrative Function
Optic-Kinesthetic motor organization. Since movement entails a number of
systems, it is necessary to check all components of the movement function in
assessing a deficit.
• Integrity of the visual-spatial basis of movement.
• Impairment of this component is due to a lesion in the inferior
parietal and/or parietoccipital region, especially on the right.
• Test-have patient reproduce the examiner's hand and pencil
movements with examiner sitting beside, then opposite, the
patient .
• Integrity of the kinesthetic basis of movement.
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• Impairment of this component, or afferent apraxia, is usually due
to a lesion in the postcentral gyrus contralateral to the impaired
side of the body. Movements tend to be awkward or diffuse in
character.
• Test-check basic sensory adequacy; then with eyes closed place
patient's hand in one position and ask him to reproduce the
position with the other hand; ask patient to reproduce position of
examiner's hands or follow verbal commands for hand position
without looking at his own.
• Integrity of motor or dynamic basis of movement.
• Impairment of this component, or efferent apraxia is due to
lesions of the premotor area, especially in the dominant
hemisphere. It results in perseverative movements and the loss of
continuity of movement.
• Test-tasks requiring reciprocal coordination of both hands,
alternating tapping patterns, ring-fist test, fist-edge-palm test, and
drawing of alternating designs.
2. Word fluency has come to be associated with the left frontal area due to its
disturbance with lesions in this region. It is hypothesized that the left hemisphere is
necessary for verbal facility and the frontal area for the ability to switch sets.
• Test-have patient write or say as many words as possible that begin with a
given letter in a given time period.
3. Severe memory deficits have been reported with bilateral temporal lesions and these
have been thought to be due to hippocampal damage. However, recently damage to
temporal stem has been postulated to produce severe learning and retention deficits
in the presence of intact hippocampi.
• Test-memory for verbal story, hidden objects, design reproduction from
memory, paired associates, and memory for four unrelated words after
interference.
.
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Angular Gyrus
A. Functions
Tertiary in function: lies at the boundary between the occipital, temporal, and
postcentral regions of the hemisphere, where the cortical areas for visual, auditory,
vestibular, cutaneous, and proprioceptive sensations overlap.
Supramodal in function: plays a special role in inter-analyzer syntheses. The
angular gyrus, as part of the inferior parietal lobule, is the association area of
association areas and allows cross modal transfer and associations between either
vision or touch and hearing . As the angular gyrus is important in the processing of
associating a heard name to a seen or felt object, it is probably also important for
associations in the reverse direction. A "name" passes through Wernicke's area,
then via the angular gyrus arouses associations in the other parts of the brain. Thus,
the angular gyrus acts as a way station between the primary sensory modalities and
the speech area.
.
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The development of language is probably heavily dependent on this area. Object
naming, one of the simplest aspects of language, depends on associations between
other modalities and audition.
Association cortex that combines visual and auditory information necessary for
reading and writing. Designed for storing the memory of the "rules of translation"
from written to spoken language.
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B. Behavioral deficits
Alexia without agraphia: results when the inferior parietal lobule is disconnected
from all visual input. Pure word blindness results due to a disconnexion from the
"memory centre".
• Reading aloud and comprehension of written words is lost.
• Ability to name and recognize objects is preserved. Objects have rich,
multiple associations in other areas, e.g. one can recognize an apple by
vision, touch, taste, smell, even by texture. The arousal of such associations
permits the finding of an alternative pathway across an uninvolved more
anterior portion of the corpus callosum.
• Persistent difficulty in color naming but can match colors by hue without
error.
• Loss of ability to read music.
• Spelling and spelling comprehension way he quite normal
• Writing should be normal or nearly so; however, subtle defects can usually
present (e.g. letters are too large or too widely spaced, there may be an
absence or misuse of punctuation, capitals may be disregarded, letters
dropped or reduplicated).
• This syndrome is referred to as agnostic alexia by Brown. He states that a
right hemanopia is an almost constant.
2. Alexia with agraphia: results from damage to the angular gyrus itself and renders
the patient unable to read and write. May be referred to as aqraphic alexia or
angular gyrus alexia.
• A loss of visual word memory returns the patient to the state of being
illiterate; lack of reading, writing, and spelling, and an incomprehension of
spelled words are all components of this more primitive state.
• Reading has a global character, without facilitation by literal analysis or letter
tracing. Paralexia is present in reading aloud, especially for letters.
• Letters are misnamed and patients cannot Indicate or sort letters accurately to
command, unless first given a visual model of the letter tested, nor can they
select the correct letter name from a spoken group. Patients are unable to
match spoken letter sounds to written letters.
• There is an inability to spell all but the simplest words, either to command or
to a presented object.
• Printing is variable, but always impaired. The agraphia reflects the spelling
deficiency, as well as, in severe cases, the loss of conceptualization of words
as whole units.
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Although specific assessment devices have not been mentioned, it would appear
that qualitative analysis of reading, writing, and spelling abilities is warranted in
assessing the above syndromes.
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Parieto-temporal-occipital cortex
This area is a tertiary, general sensory association area that integrates visual, tactile, and
auditory information.
A. Lesions of this area will produce complex disorders that may include:
Constructional Apraxia: defects in copying designs and in drawing to command.
• Left hemisphere lesions: ordering of movements is disrupted, simplification
of drawings, difficulty making angles.
• Right hemisphere lesions: more severe deficits such as visuo-spatial defects,
neglect of left side of drawing, disproportions.
Difficulties in serial ordering: comprehension of order and sequence.
• Left hemisphere lesions: disruption of sequential organization of speech.
• Right hemisphere lesions: cannot understand temporal relationships and is
unable to make future plans.
Visual memory disturbance: defective revisualization
• Left hemisphere lesions: inability to evoke visual image in response to a
given word.
• Right hemisphere lesions: inability to retain visual image of nonverbal,
spatial figures.
Impaired recognition and comprehension of complex, symbolic stimuli.
• Left hemisphere lesions only
• Symptoms of aphasia may also be seen.
B. Tests to measure the above deficits
Constructional apraxia
• Copying designs: diamond, cross, cube, pipe.
• Drawing to command: clock, daisy in flowerpot, house in perspective.
• Match stick pattern test.
• Block construction test.
Difficulties in serial ordering
• Observations of spontaneous speech
• Ability to order events in time: both life history events and objective events
such as the Presidential terms .
Visual memory disturbance
• Left hemisphere: Ask patient to describe objects that are not present
• Right hemisphere: Short-term visual memory for geometric patterns
Impaired comprehension of complex symbolic stimuli
• Ask patient to explain complex logico-gram-matical constructions such as
"brother's father"
• Give commands such as "draw a circle under a square"
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